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The information provided in this documentation contains general descriptions and/or technical character-
istics of the performance of the products contained herein. This documentation is not intended as a 
substitute for and is not to be used for determining suitability or reliability of these products for specific user 
applications. It is the duty of any such user or integrator to perform the appropriate and complete risk 
analysis, evaluation and testing of the products with respect to the relevant specific application or use 
thereof. Neither Schneider Electric nor any of its affiliates or subsidiaries shall be responsible or liable for 
misuse of the information contained herein. If you have any suggestions for improvements or amendments 
or have found errors in this publication, please notify us. 
No part of this document may be reproduced in any form or by any means, electronic or mechanical, 
including photocopying, without express written permission of Schneider Electric.
All pertinent state, regional, and local safety regulations must be observed when installing and using this 
product. For reasons of safety and to help ensure compliance with documented system data, only the 
manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant instructions must 
be followed. 
Failure to observe this information can result in injury or equipment damage.
© 2020 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device before 
trying to install, operate, or maintain it. The following special messages may appear throughout this 
documentation or on the equipment to warn of potential hazards or to call attention to information that 
clarifies or simplifies a procedure.

PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified personnel. 
No responsibility is assumed by Schneider Electric for any consequences arising out of the use of this 
material.
A qualified person is one who has skills and knowledge related to the construction and operation of 
electrical equipment and its installation, and has received safety training to recognize and avoid the 
hazards involved.
EIO0000002071 06/2020 5
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About the Book
At a Glance

Document Scope
This manual describes the installation and configuration of the Modicon MC80 PLC’s hardware, software, 
and main accessories.

Validity Note
This documentation is valid for Unity Pro 8.1 and later versions.

Product Related Information

WARNING
UNINTENDED EQUIPMENT OPERATION
The application of this product requires expertise in the design and programming of control systems. Only 
persons with such expertise should be allowed to program, install, alter, and apply this product.
Follow all local and national safety codes and standards.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
EIO0000002071 06/2020 7
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Part I
Modicon MC80 PLC
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Chapter 1
Introduction to Modicon MC80 PLC

Modicon MC80 PLC 

General Description
Modicon MC80 PLC is an automated platform processor which is compact with discrete I/O functions, 
analog input functions, counting functions, and communication functions. 

Illustration
The following figure shows the parts of Modicon MC80 PLC:

1 Power supply input
2 USB port
3 Reset button
4 Ethernet link
5 Rotary switch for IP addressing
6 I/O functions
7 Grounding screw
8 Serial link
9 CANopen link

The following table provides the details of the BMK C80 ••••• processors:

The MC80 PLC is compatible with the terminal blocks BMX FTB 20x0 and BMX FTB 28x0 which needs to 
be ordered separately.

Processor Description
BMK C80 20310 Controller, 8 DI, 8 DO, and 2 HSC
BMK C80 20301 Controller, 8 DI, 12 DO, and 4 AI
BMK C80 30311 Controller, 8 DI, 12 DO, 2 HSC, and 4 AI
EIO0000002071 06/2020 11
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Part II
MC80 Hardware Implementation

What Is in This Part?
This part contains the following chapters:

Chapter Chapter Name Page
2 Introduction to Modicon MC80 PLC Processor 15
3 Installation of Modicon MC80 PLC 21
4 Power Supply 25
5 Discrete Input and Output Function (8 Input 8 Output) 29
6 Discrete Inputs and Outputs (8 Input 12 Output) 39
7 Analog Input Function 49
8 High Speed Counting Input and Output Function 57
9 Communication 67

10 Grounding of PLC 77
11 Operating Standards and Conditions 81
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Chapter 2
Introduction to Modicon MC80 PLC Processor

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
General Introduction 16
General Characteristics of the Processor 17
Execution of Tasks 19
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Introduction to Modicon MC80 PLC Processor
General Introduction

Description
Modicon MC80 processor is an automated platform processor which manages the entire PLC station made 
up of discrete I/O functions, analog input functions, counting functions, and communication functions.
MC80 PLCs are available in these variants
 BMK C80 20310
 BMK C80 20301
 BMK C80 30311

Features
The main features of Modicon MC80 processor are:
 CANopen master limited to 16 devices
 Dual Ethernet port with embedded switch
 Serial line RS485/RS232
 USB port
 Discrete Inputs
 Discrete Outputs
 High Speed Counter function
 Analog Inputs function
NOTE: For details, see the input/output combination (see page 17).
16 EIO0000002071 06/2020



Introduction to Modicon MC80 PLC Processor
General Characteristics of the Processor

Description
This matrix provides the details for CPU reference and Input/Output functions:

BMK C80 ••••• Processor Characteristics
The following table lists the characteristics of the BMK C80 ••••• processors:

BMK C80 20310 BMK C80 20301 BMK C80 30311
Number of Discrete 
Inputs

8 standard + 12 from HSC 
channels

8 standard 8 standard + 12 from HSC 
channels

Number of Discrete 
Outputs

8 standard + 4 from HSC 
channels

12 standard (2.0 A) 12 standard (2.0 A) + 4 from 
HSC channels

Number of Analog 
Inputs

- 4 4

Number of High 
Speed Counter

2 channels (6 DI and 2 DO per 
channel)

- 2 channels (6 DI and 2 DO 
per channel)

Modbus connection X X X
Integrated CANopen 
master connection

X X X

Integrated Ethernet 
connection

X X X

X: Accessible function
-: Inaccessible function

Processor BMK C80 •••••
Description RS232/RS485, USB, Serial port, Ethernet, CANopen
Retention memory capacity 128 kB
User application memory 3,584 kB
RTC Accuracy Powered 16 minutes per year @25 °C (without calibration)

Non-powered 12 seconds per 72 hours @25 °C (retention duration)
Retention time 72 hours
Battery Without

USB physical 
spec.

Type USB2.0 Device
Speed mode Full speed mode (12 Mbps)

Serial port RJ45, RS232/RS485.
300…19,200 bps 
Modbus slave, Modbus master RTU/ASCII, Character mode.

Ethernet port 2
CANopen Up to 16 devices
LED display PWR (green)

RUN (green)
ERR (red)
SER COM (yellow)
IO (red)
CAN RUN (green)
CAN ERR (red)
ETH STS (green) 

Real-time Clock Date and time with 1 ms resolution (resolution is 1 sec when power is 
off).
EIO0000002071 06/2020 17



Introduction to Modicon MC80 PLC Processor
The following figure shows the LED indicator:

The following table lists the definition of the LED indicators:

The following table shows LED combination for CPU state (S=solid, 0=OFF, B=blinking):

Label Color Description
PWR Green Indicates the power supply status
RUN Green Indicates the module operation status
ERR Red Indicates the detected errors of the module
IO Red Indicates the detected error on IO ports

RUN ERR IO CPU State
B B B The CPU is booting or executing power on self tests or detects an invalid or missing 

OS.
0 B 0 The CPU is not configured
B 0/B 0/S The CPU is in stop state.

ERR LED blinking if non fatal error is 
detected

off if the error is not detected.
IO LED solid if there is an IO error.

off if there is no IO error.
S 0/B 0/S The CPU is in RUN mode.
0 S S The Fatal error is detected and the CPU has permanent reset, no communication is 

available.
B S 0 Firmware download is in progress
A LED can have three states: solid, off, or blinking at 2 Hz (time on = time off = 250 ms). When the product is powered, 
there is at least one LED in Solid or Blinking state, irrespective of the CPU state.
18 EIO0000002071 06/2020



Introduction to Modicon MC80 PLC Processor
Execution of Tasks

Description
The MC80 processor supports MAST task with periodic and cyclic modes.

Master Task
The master task represents the application program’s main task. You can choose from the following MAST 
task execution modes:
 Cyclical (default setup): execution cycles are performed in sequence, one after the other.
 Periodical: a new cycle is started periodically, according to a user-defined time period (1…255 ms) with 

1 ms increment.
If the execution time is longer than the period configured by you, then the bit %S19 is set to 1 and a new 
cycle is launched.
Both MAST task cycle modes are controlled by a watchdog.
The watchdog is triggered if the MAST task execution time is longer than the watchdog value in the 
configuration, and causes a software error. The application then goes into HALT status, and the bit %S11 
is set to 1 (you must reset it to 0).
The watchdog value (%SW11) may be configured between 10 ms and 1,500 ms (default value: 250 ms).
NOTE: Configuring the watchdog to a value that is less than the period is not allowed.
The system tasks with higher priority than MAST will have an impact of MAST task duration.
The following table shows how the main services are assigned to a priority (highest priority impacts all 
services with lowest priority):

Highest priority Interrupts: system timer, CAN, ETH, USB, serial ports

Exception handler task (1)

RSTP
Ethernet frame process

PLC operating mode transition management (run, stop, new download) (2)

CANopen process
MAST task
PLC low priority task: online change, application backup to flash

Lowest priority Other Ethernet services: DHCP, SNMP
(1) Exception lead to error state and permanent reset of the function
(2) Task activated only on PLC state change
EIO0000002071 06/2020 19



Introduction to Modicon MC80 PLC Processor
20 EIO0000002071 06/2020



Modicon MC80 Programmable Logic Controller (PLC)
Installation of Modicon MC80 PLC
EIO0000002071 06/2020
Installation of Modicon MC80 PLC

Chapter 3
Installation of Modicon MC80 PLC

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Dimensions and Mounting 22
Installation Rules 24
EIO0000002071 06/2020 21



Installation of Modicon MC80 PLC
Dimensions and Mounting

Dimensions of MC80 PLC
The following figure shows the overall dimensions of the MC80 PLC:

NOTE: The terminal block should be ordered separately. This equipment is "enclosed". It can be installed 
without any specific protection in areas with restricted access and low pollution levels (not exceeding 2). 
In other environments, it is recommended to follow rules of installation in a cabinet. Refer to Control Expert 
documentation, Chapter "General Safety Instructions for the user": 6.2 Environmental conditions. 
For compliance to UL (Underwriters Laboratories) requirements, the product is an "open equipment".
For North America systems, the installation and operation of this equipment in an end fire enclosure 
appropriately rated for its intended environment.

Mounting and Fastening the MC80 PLC
MC80 PLC can be mounted on:
 DIN rails of 35 mm (1.38 in.) wide
 Panels

Mounting on DIN Rails
The following are the two types of DIN rails used for mounting MC80 PLC:
 Mounting on a 35 mm (1.38 in.) wide and 15 mm (0.59 in.) deep DIN rails
 Mounting on a 35 mm (1.38 in.) wide and 7.5 mm (0.295 in.) deep DIN rails
The following table describes the procedure for mounting the MC80 PLC on a DIN rail:

To remove the MC80 product, perform the mounting procedure in reverse.
Press down on the product (1) in order to compress the springs, then tip the product forwards to disengage 
it from the rail (2).
NOTE: To make sure that the PLCs continue to operate correctly when there is severe electromagnetic 
interference, you must mount the modules on properly grounded metallic mountings.

Step Description Illustration
1 Position the PLC on the DIN rail as indicated in 

the figure.
The following figure shows the mounting on a DIN rail:

2 Press down on the MC80 product (1) in order to 
compress the springs, then tip the product 
backwards against the rail (2).

3 Release the MC80 product to lock it.
22 EIO0000002071 06/2020



Installation of Modicon MC80 PLC
Mounting on Panels
The figure below shows the screw-hole layout for mounting the MC80 PLC on a panel (dimensions in 
mm/inch):

The diameter of the fastening holes must allow the use of M4 screws.
NOTE: Tighten the screw to help ensure the contact between the BKP and the panel.
EIO0000002071 06/2020 23



Installation of Modicon MC80 PLC
Installation Rules

Introduction
When assembling MC80 module, you must comply with certain installation rules.

Module Installation Rules: Description

If MC80 is installed in a cabinet, you are advised to comply with the following measures:
 leave a minimum space of 80 mm (3.15 inch) above and 60 mm (2.36 inch) below the modules to 

facilitate air circulation
 leave a minimum space of 60 mm (2.36 inch) between the modules and the wiring ducts to facilitate air 

circulation
The minimum depth of the cabinet should be:
 150 mm (5.91 inch) if the rack is fastened to a plate
 160 mm (6.30 inch) if the rack is mounted on a 15 mm (0.59 inch) deep DIN rail

The following figure shows the rules of installation in a cabinet: 

a Greater than or equal to 60 mm (2.36 inch)
b Greater than or equal to 80 mm (3.15 inch)
1 Installation or casing
2  Wiring duct or tray

WARNING
UNEXPECTED EQUIPMENT OPERATION
Install MC80 lengthways and horizontally to facilitate ventilation.
MC80 is cooled by natural convection. Other positions may cause overheating and unexpected 
equipment operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
INADEQUATE THERMAL CLEARANCE
Maintain proper thermal distances when installing the MC80 to prevent overheating and unexpected 
equipment operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
24 EIO0000002071 06/2020
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Chapter 4
Power Supply

Power Supply

Description
A galvanic isolated 24 Vdc power supply on MC80 PLC supplies the whole module.
A LED function is mounted on the power supply function to indicate the module and communication status. 
A reset button is also placed on the power supply function.
The following table contains the main physical features of power supply:

Representation

1 Reset button
2 24 V Power socket

Item Specification
Input type DC
Nominal Input Voltage 24 Vdc
Input Voltage range 20.4…28.8 Vdc
Current 700 mA max.
Isolation level 1,500 Vdc (@0...2,000m)
EIO0000002071 06/2020 25



Power Supply
The following figure shows the power connector: 

The below table lists the pin assignment of the connector:

The following figure shows the insertion of 3-pin terminal block in the power supply:

DC Power Supply Requirements
The MC80 PLCs require power supplies with a nominal voltage of 24 Vdc.
The 24 Vdc power supplies must be rated Protective Extra Low Voltage (PELV) according to IEC 61140.
These power supplies are isolated between the electrical input and output circuits of the power supply.

Pin No. Signal Name Description
1 24 V DC 24 V input
2 0 V
3 FG Functional Ground

WARNING
POTENTIAL OF OVERHEATING AND FIRE 
 Do not connect the equipment directly to line voltage.
 Use only isolating PELV power supplies to supply power to the equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
26 EIO0000002071 06/2020



Power Supply
Rules of Wiring
The below table shows the description of the terminal block:

Reset Button
The Reset button can be used to activate a cold start whenever necessary. The pressing time should be 
a minimum of 20 ms.

Description Terminal Block
Number of wires per point 1 wire per point
Wire gauge AWG 18-16, 0.8-1.3 mm²
Maximum screw tightening torque Depends on connector supplied (*)
Cable Ends and Contacts The terminal block can accommodate:

 Bare wires

 Wires with DZ5-CE type cable ends: 

Temperature range of wires Minimum 105 °C
(*) For connector Dinkle 0.50 N•m (4.5 lb.ft)
 For connector Phoenix Contact 0.56 N•m (5.0 lb.ft)
 For connector FCI 0.330 N•m (3.0 lb.ft)
 For connector Weidmuller 0.50 N•m (4.5 lb.ft)
EIO0000002071 06/2020 27
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Chapter 5
Discrete Input and Output Function (8 Input 8 Output)

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Discrete Input and Output Function (8 Input 8 Output) 30
Connecting Discrete I/O Function (8 Input 8 Output) 33
Fitting a 20-Pin Terminal Block 35
20-Pin Terminal Block Modules 36
Discrete I/O Function (8 Input 8 Output) and Channel Status Display 38
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Discrete Input and Output Function
Discrete Input and Output Function (8 Input 8 Output)

Description
The Discrete Input and Output (Discrete I/O) is a 24 Vdc function connected using a 20-pin terminal block 
(BMXFTB20x0). It is a positive logic function where the eight input channels receive current from the 
sensors (sink) and the eight output channels provide current to the pre-actuators (source).
This discrete I/O function is available on the BMK C80 20310 PLC.

General Input Characteristics
These are the general input characteristics of the Discrete I/O function:

Input Fuses

Characteristic Description Value
Nominal input values Voltage 24 Vdc

Current 5 mA
Threshold input values At 1 Voltage ≥11 V

Current >2 mA for U≥11 V
At 0 Voltage ≤5 V

Current ≤1.5 mA
Sensor supply (including ripple) 19…30 V

Input impedance At nominal U 4.8 kΩ
Response time Disappearance/appearance 4 ms<T<5 ms
IEC 61131-2- Edition 2 (2007) Type 3
Reverse polarity Input Provides an external fuse to the sensor 24 V.
2-wire/3-wire proximity sensor compatibility IEC 947-5-2
Dielectric strength Between PLC bus and field sides 1,500 Vdc for 1 minute

Between input and output groups 500 Vdc
Resistance of insulation >10 MΩ (at 500 Vdc)
Type of input Current sink
Paralleling of inputs No
Sensor voltage monitoring threshold No
Sensor power supply 
(8 inputs on)

Typical 46 mA
Maximum 51 mA

24 V sensor power supply 
(excluding load current)

Typical 26 mA
Maximum 35 mA

24 V sensor power supply consumption@25 °C (all channels OFF) 10.11 mA
24 V sensor power supply consumption@25 °C (all channels ON) 46.11 mA

WARNING
LOSS OF INPUT FUNCTION
Do not implement the voltage over maximum limit value.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Fuse Value
Internal None
External 1 fast blow fuse of 0.5 A for the input group
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Discrete Input and Output Function
General Output Characteristics
The following table shows the general output characteristics of the Discrete I/O function:

(1) All outputs are equipped with fast demagnetization circuits for electromagnets. Electromagnet discharge 
time < L/R.
(2) Users have to control the two parallel channels simultaneously to avoid overload on one channel. Users 
can only parallel two channels both from first 4 channels (Channel 16 to 19), or parallel two channels both 
from the last 4 channels (Channel 20 to 23). Paralleling one channel from first 4 channels (Channel 16 to 
19) with another channel from the last 4 channels (Channel 20 to 23) is forbidden.
(3) Provide a 2 A fuse to the +24 V pre-actuator supply.

CAUTION
LOSS OF INPUT FUNCTION
Install the correct rating and type of fuse.
Failure to follow these instructions can result in injury or equipment damage.

Characteristic Description Value
Nominal values Voltage 24 Vdc

Current 0.5 A
Limited values Maximum voltage 19…30 V

Maximum current for overflow 
protection/Channel (single 
channel shutdown)

0.625 A

Power of tungsten filament 
lamp

Maximum 6 W

Leakage current At 0 <0.5 mA
Voltage drop At 1 <1.2 V
Load impedance Minimum 48 Ω

Response time(1) <1.2 ms

Frequency of switching to inductive load 0.5/LI² Hz
Paralleling of outputs Yes (maximum of 2 channels and total 1 A) (2).
Built-in protection Against inversions Yes, by inverted diode(3).

Against short circuits and 
overloads

Yes, by internal current limiter at 0.7 A<Id<1.7 A 
(typical 1 A) after internal over-temperature is 
detected

Pre-actuator voltage: 
monitoring threshold

OK >19 Vdc (max.)
Fault <14 Vdc (typ.) 

Pre-actuator voltage: 
monitoring response time

On appearance 2 ms<T<4 ms
On disappearance 9 ms<T<11 ms

24 V pre-actuator 
consumption (excluding 
load current)

Typical 26 mA
Maximum 35 mA

Dielectric strength Between PLC bus and field sides 1,500 Vdc for 1 minute
Resistance of insulation >10 MΩ (at 500 Vdc)

WARNING
LOSS OF OUTPUT FUNCTION
Do not implement the voltage over maximum limit value.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Discrete Input and Output Function
Output Fuses

Fuse Value
Internal None
External 1 fast blow fuse of 6.3 A for the output group

CAUTION
LOSS OF OUTPUT FUNCTION
Install the correct rating and type of fuse.
Failure to follow these instructions can result in injury or equipment damage.
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Discrete Input and Output Function
Connecting Discrete I/O Function (8 Input 8 Output)

Description
The Discrete I/O (8 Input 8 Output) function is fitted with a removable 20-pin terminal block (BMXFTB20x0) 
for the connection of eight input channels and eight output channels.

Input Circuit Diagram
The following diagram shows the circuit of a direct current input (positive logic).

Output Circuit Diagram
The following diagram shows the circuit of a direct current output (positive logic).
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Discrete Input and Output Function
Discrete I/O Connection
The following diagram shows the connection of the function to the sensors and pre-actuators.

power supply: 24 Vdc
input fuse: fast blow fuse of 0.5 A
output fuse: fast blow fuse of 6.3 A
pre-act: pre-actuator

The following table lists the suitable terminal block references for Discrete Input & Output function:

NOTE: Make sure to follow the correct connection to the sensors and pre-actuators.

I/O Function Reference Number
Discrete Input & 
Output function

BMX FTB 2000
BMX FTB 2010
BMX FTB 2020
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Discrete Input and Output Function
Fitting a 20-Pin Terminal Block

Installing the 20-Pin Terminal Block
The following table shows the assembling of the 20-pin terminal block onto I/O functions tightening torque 
0.4 N•m (0.30 lb-ft):

NOTE: If the screws are not tightened, the terminal block may not be properly fixed to the module.
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Discrete Input and Output Function
20-Pin Terminal Block Modules

At a Glance
The Discrete I/O (8 Input 8 Output) and Analog Input functions are supplemented by a 20-pin terminal 
block.
There are three types of 20-pin terminal blocks:
 BMX FTB 2010 screw clamp terminal blocks
 BMX FTB 2000 caged terminal blocks
 BMX FTB 2020 spring terminal blocks

Cable Ends and Contacts
Each terminal block can accommodate:
 Bare wires

 Wires with DZ5-CE type cable ends: 

Description of the 20-Pin Terminal Blocks
The table below shows the description of the 3 types of 20-pin terminal blocks:

Screw clamp terminal blocks Caged terminal blocks Spring terminal blocks
Illustration

Number of wires accommodated 2 1 1
Number of wire 
gauges 
accommodated

minimum AWG 24 (0.34 mm2)
maximum AWG 16 (1.5 mm2)

Wiring constraints Screw clamps have slots that 
accept:
 flat-tipped screwdrivers with a 

diameter of 5 mm,
 posidriv n° 1 cross-tipped 

screwdrivers.
Screw clamp terminal blocks 
have captive screws. On the 
supplied blocks, these screws are 
not tightened.

Caged terminal blocks have slots 
that accept:
 flat-tipped screwdrivers with a 

diameter of 3 mm,
 posidriv n° 1 cross-tipped 

screwdrivers.
Caged terminal blocks have 
captive screws. On the supplied 
blocks, these screws are not 
tightened.

The wires are connected by 
pressing on the button located 
next to each pin. To press on the 
button, you have to use a flat-
tipped screwdriver with a 
maximum diameter of 3 mm.

Maximum screw tightening torque 0.5 N•m (0.37 lb-ft). 0.5 N•m (0.37 lb-ft). -
Temperature range of wire Minimum 105 °C

DANGER
ELECTRICAL SHOCK
The terminal block must be connected or disconnected with sensor and pre-actuator voltage switched off.
Failure to follow these instructions will result in death or serious injury.
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Discrete Input and Output Function
Labeling of 20-Pin Terminal Blocks
Labels for the 20-pin terminal blocks are supplied with the module. They are to be inserted in the terminal 
block cover by the customer.
Each label has two sides:
 One side that is visible from the outside when the cover is closed. This side features the commercial 

product references, an abbreviated description of the module, as well as a blank section for customer 
labeling.

 One side that is visible from the inside when the cover is open. This side shows the terminal block 
connection diagram.
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Discrete Input and Output Function
Discrete I/O Function (8 Input 8 Output) and Channel Status Display

Description
The Discrete I/O functions are equipped with a display block featuring LEDs that displays the functions 
channel status and the overall function status.

Representation
The below figure shows the LED indicator of the Discrete I/O function:

NOTE: The mixed input/output function has two groups of eight channels. The input group is represented 
by channels 0…7 and the output group is represented by channels 16…23.
The following table helps you to perform diagnostics of the discrete I/O function status according to the 
channel LEDs:

NOTE: 
 Display of internal or external events is effective once the module is configured.
 When an event is detected, the channel status is recorded until the cause of the event is cleared.
 The output channel is closed by default.

Status Meaning
0...7 16...23
ON - Voltage is present on the input channel
- ON Voltage is present on the output channel
- BLK Actuator supply fails
- FLK Output channel is overload/short-circuit
Legends
- Not applicable
ON LED is steady on
BLK (Blinking) The LED is turned on for 200 ms, then turned off for 200 ms
FLK (Flickering) The LED is turned on for 50 ms, then turned off for 50 ms

WARNING
CHANNEL LED INFORMATION NOT MATCHING SENSORS VALUE
After a sensor power outage:
 Do not take into account the input LEDs information (they show the last recorded value of the sensors, 

not their real value).
 Check the real positions on the sensors.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Chapter 6
Discrete Inputs and Outputs (8 Input 12 Output)

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Discrete Input and Output Function (8 Input 12 Output) 40
Connecting Discrete I/O Function 43
Fitting a 28-Pin Terminal Block 45
28-Pin Terminal Block Modules 46
Discrete I/O Function (8 Input 12 Output) and Channel Status Display 48
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Discrete Inputs and Outputs (8 Input 12 Output)
Discrete Input and Output Function (8 Input 12 Output)

Description
The Discrete Input and Output (Discrete I/O) is a 24 Vdc function connected using a 28-pin terminal block 
(BMXFTB28x0). It is a positive logic function where the 8 input channels receive current from the sensors 
(sink) and the 12 output channels provide current to the pre-actuators (source).
The Discrete I/O function is available on the following PLC:
 BMK C80 20301
 BMK C80 30311

General Input Characteristics
The following table shows the general input characteristics of the Discrete I/O function:

Characteristic Description Value
Nominal input values Voltage 24 Vdc

Current 2.4 mA
Threshold input values At 1 Voltage ≥11 V

Current >2 mA for U≥11 V
At 0 Voltage ≤5 V

Current ≤1.5 mA
Sensor supply (including ripple) 19…30 V

Input impedance At nominal U 10 kΩ
Sensor supply monitoring 
threshold

OK >17V(Typical)
Fault <8V(Typical)

Response time Disappearance/appearance 4 ms<T<5 ms
IEC 61131-2- Edition 2 (2007) Type 3
Reverse polarity Input Provides an external fuse to the sensor 24 V.
2-wire/3-wire proximity sensor compatibility IEC 947-5-2
Dielectric strength Between PLC bus and field sides 1,500 Vdc for 1 minute

Between input and output groups 500 Vdc
Resistance of insulation >10 MΩ (at 500 Vdc)
Type of input Current sink
Paralleling of inputs No
Sensor voltage monitoring threshold No
Sensor power supply 
(8 inputs on)

Typical 30 mA
Maximum 35 mA

24 V sensor power supply 
(excluding load current)

Typical 8 mA
Maximum 10 mA

24 V sensor power supply consumption@25 °C (all channels OFF) 8 mA
24 V sensor power supply consumption@25 °C (all channels ON) 30 mA

WARNING
LOSS OF INPUT FUNCTION
Do not implement the voltage over maximum limit value.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Discrete Inputs and Outputs (8 Input 12 Output)
Input Fuses

General Output Characteristics
The following table shows the general output characteristics of the Discrete I/O function:

(1) 2.5A for ambient temperature under 60°C; 2A for ambient temperature from 60°C to 70°C 
(2) All outputs are equipped with fast demagnetization circuits for electromagnets. Electromagnet discharge 
time < L/R.
(3) Users have to control the two parallel channels simultaneously to avoid overload on one channel.
(4) Provide a 12 A fuse to the +24 V pre-actuator supply.

Fuse Value
Internal None
External 1 fast blow fuse of 0.5 A for the input group

CAUTION
LOSS OF INPUT FUNCTION
Install the correct rating and type of fuse.
Failure to follow these instructions can result in injury or equipment damage.

Characteristic Description Value
Nominal values Voltage 24 Vdc

Current 2 A
Limited values Maximum voltage 19…30 V

Current/Channel 2.5 (1)
Current/12 channels 10 A

Power of tungsten filament 
lamp

Maximum 60 W

Leakage current At 0 <0.5 mA
Voltage drop At 1 <1.2 V
Load impedance Minimum 12 Ω

Response time(2) <1.2 ms

Frequency of switching to inductive load 0.5/LI² Hz
Paralleling of outputs Yes (maximum of 2 channels and total 4 A) (3).
Built-in protection Against inversions Yes, by inverted diode(4).

Against short circuits and 
overloads

Yes, internal current limiter will limit output 
transience current at 7 A after internal over-
temperature is detected

Pre-actuator voltage: 
monitoring threshold

OK >19 Vdc (max.)
Fault <14 Vdc (typ.) 

Pre-actuator voltage: 
monitoring response time

On appearance 2 ms<T<4 ms
On disappearance 9 ms<T<11 ms

24 V pre-actuator consumption 
(excluding load current)

Typical 26 mA
Maximum 35 mA

Dielectric strength Between PLC bus and field sides 1,500 Vdc for 1 minute
Resistance of insulation >10 MΩ (at 500 Vdc)
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Discrete Inputs and Outputs (8 Input 12 Output)
Output Fuses

WARNING
LOSS OF OUTPUT FUNCTION
Do not implement the voltage over maximum limit value.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Fuse Value
Internal None
External 1 fast blow fuse of 12 A for the output group

CAUTION
LOSS OF OUTPUT FUNCTION
Install the correct rating and type of fuse.
Failure to follow these instructions can result in injury or equipment damage.
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Discrete Inputs and Outputs (8 Input 12 Output)
Connecting Discrete I/O Function

Description
The Discrete I/O function is fitted with a removable 28-pin terminal block (BMXFTB28x0) for the connection 
of 8 input channels and 12 output channels.

Input Circuit Diagram
The following diagram shows the circuit of a direct current input (positive logic).

Output Circuit Diagram
The following diagram shows the circuit of a direct current output (positive logic).
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Discrete Inputs and Outputs (8 Input 12 Output)
Discrete I/O Connection
The following diagram shows the connection of the function to the sensors and pre-actuators.

power supply: 24 Vdc
input fuse: fast blow fuse of 0.5 A
output fuse: fast blow fuse of 12 A
pre-act: pre-actuator

The following table lists the suitable terminal block references for Discrete Input & Output function:

NOTE: Make sure to follow the correct connection to the sensors and pre-actuators.

I/O Function Reference Number
Discrete Input & Output function BMX FTB 28x0
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Discrete Inputs and Outputs (8 Input 12 Output)
Fitting a 28-Pin Terminal Block

Installing the 28-Pin Terminal Block
The following table shows the assembling of the 28-pin terminal block onto I/O functions tightening torque 
0.4 N•m (0.30 lb-ft):

NOTE: If the screws are not tightened, the terminal block may not be properly fixed to the module.
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Discrete Inputs and Outputs (8 Input 12 Output)
28-Pin Terminal Block Modules

At a Glance
The Discrete I/O function is supplemented by a 28-pin terminal block.
There are two types of 28-pin terminal blocks:
 BMX FTB 2820 spring terminal blocks
 BMX FTB 2800 caged terminal blocks

Cable Ends and Contacts
The terminal block can accommodate:
 Bare wires

 Wires with DZ5-CE type cable ends: 

Description of the 28-Pin Terminal Blocks
The table below shows the description of the 28-pin terminal blocks:

Spring terminal blocks Caged terminal blocks
Illustration

Number of wires accommodated 1 1
Number of wire gauges 
accommodated

minimum 0.25 mm2 (AWG 24)
maximum 1.5 mm2 (AWG 16)

Wiring constraints The wires are connected by pressing on the button 
located next to each pin. To press on the button, 
you have to use a flat-tipped screwdriver with a 
maximum diameter of 3 mm.

Caged terminal blocks have slots that accept:
 flat-tipped screwdrivers with a diameter of 3 

mm,
 posidriv n° 1 cross-tipped screwdrivers.

Caged terminal blocks have captive screws. On 
the supplied blocks, these screws are not 
tightened.

Maximum screw tightening torque - 0.5 N•m (0.37 lb-ft).
Temperature range of wire Minimum 105 °C

DANGER
ELECTRICAL SHOCK
The terminal block must be connected or disconnected with sensor and pre-actuator voltage switched off.
Failure to follow these instructions will result in death or serious injury.
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Discrete Inputs and Outputs (8 Input 12 Output)
Labeling of 28-Pin Terminal Blocks
Labels for the 28-pin terminal blocks are supplied with the module. They are to be inserted in the terminal 
block cover by the customer.
Each label has two sides:
 One side that is visible from the outside when the cover is closed. This side features the commercial 

product references, an abbreviated description of the module, as well as a blank section for customer 
labeling.

 One side that is visible from the inside when the cover is open. This side shows the terminal block 
connection diagram.
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Discrete Inputs and Outputs (8 Input 12 Output)
Discrete I/O Function (8 Input 12 Output) and Channel Status Display

Description
The Discrete I/O functions are equipped with a display block featuring LEDs that displays the functions 
channel status and the overall function status.

Representation
The below figure shows the LED indicator of the Discrete I/O function:

NOTE: The mixed input/output function has two groups of 8 input and 12 output channels. The input group 
is represented by channels 0…7 and the output group is represented by channels 16…27.
The following table helps you to perform diagnostics of the discrete I/O function status according to the 
channel LEDs:

NOTE: 
 Display of internal or external events is effective once the module is configured.
 When an event is detected, the channel status is recorded until the cause of the event is cleared.
 The output channel is closed by default.

Status Meaning
0...7 16...27
ON - Voltage is present on the input channel
- ON Voltage is present on the output channel
- BLK Actuator supply fails
- FLK Output channel is overload/short-circuit
Legends
- Not applicable
ON LED is steady on
BLK (Blinking) The LED is turned on for 200 ms, then turned off for 200 ms
FLK (Flickering) The LED is turned on for 50 ms, then turned off for 50 ms

WARNING
CHANNEL LED INFORMATION NOT MATCHING SENSORS VALUE
After a sensor power outage:
 Do not take into account the input LEDs information (they show the last recorded value of the sensors, 

not their real value).
 Check the real positions on the sensors.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Chapter 7
Analog Input Function

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Analog Input Function Overview 50
Analog Input Functional Description 51
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Analog Input Function
Analog Input Function Overview

Description
The Analog Input is a high level analog input function with four non-isolated channels. This function is used 
to measure and monitor the continuous process control functions.
The Analog Input function is available on these PLCs:
 BMK C80 20301
 BMK C80 30311

General Characteristics
These are the general characteristics of the Analog Input function:

NOTE: Help ensure that the inputs connected to the analog voltage and current channels are within the 
maximum load limit, else it will lead to the breakage of inputs.

Measurement Range
The Analog Input function has the following measurement range characteristics:

NOTE: If nothing is connected to an Analog Input function and if the channel is configured (range 4…20 mA 
or 1…5 V), an I/O error is detected in the form of broken wire.

Parameter Characteristics
Type of inputs High level Fast inputs with common point
Nature of inputs Voltage/Current (250 Ω internally protected resistors)
Number of channels 4
Acquisition cycle time Fast (periodic acquisition for the 

declared channels used)
1.3 ms + 1.3 ms x number of channels used

Default (periodic acquisition for 
all channels)

6.5 ms

Display resolution (pk to pk resolution) 16-bit Σ Δ
Digital filtering 1st order
Isolation Between channels None

Between channels and bus 1,400 Vdc
Between channels and ground 1,400 Vdc

Maximum overload 
authorized for inputs

Voltage inputs ±30 Vdc
Current inputs ±90 mA

Measurement range ±10 V; ±5 V; 0…10 V; 0…5 V; 1…5 V 0...20 mA; 4...20 mA; ±20 mA
Maximum conversion value ±11.4 V ±30 mA
Conversion resolution 0.35 mV 0.92 μA
Input impedance 10 MΩ 250 Ω Internal conversion resistor
Precision of the internal conversion 
resistor

- 0.1% - ±15 ppm/°C

Measurement errors for standard function:
At 25 °C 0.075% of FS(1) 0.15% of FS(1)(2)

Maximum in the temperature range -
25…70 °C (-13…158 °F)

0.2% of FS(1) 0.55% of FS(1)(2)

Temperature drift 15 ppm/°C 30 ppm/°C
Monotonicity Yes Yes
Crosstalk between channels DC and 
AC 50/60 Hz

>70 dB >70 dB

Non-linearity 0.05% of FS 0.05% of FS
Repeatability @25 °C of 10 minutes 
stabilization time

0.005% of FS 0.007% of FS

Long term stability after 1000 hours <0.004% of FS <0.004% of FS
(1) FS: Full Scale
(2) With conversion resistor error
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Analog Input Function
Analog Input Functional Description

Description
The Analog Input function offers the following range for each input according to the selection made during 
configuration:
 ±10 V
 0…10 V
 0…5 V/0…20 mA
 1…5 V/4…20 mA
 ±5 V/±20 mA
The function operates with voltage inputs. It includes four read resistors connected to the terminal block to 
perform current inputs.

Measurement Timing
The timing of measurements is determined by the cycle selected during configuration (Normal or Fast 
Cycle):
 Normal Cycle means that the scan cycle duration is fixed.
 With the Fast Cycle, however, the system only scans the channels designated as being In Use. The 

scan cycle duration is therefore proportional to the number of channels In Use.
The cycle time values are based on the cycle selected:

NOTE: Module cycle is not synchronized with the PLC cycle. At the beginning of each PLC cycle, each 
channel value is taken into account. If the MAST task cycle time is less than the module’s cycle time, some 
values would have not changed.

Overflow/Underflow Control
The Analog Input function allows you to select between six voltage or current ranges for each input. This 
option has to be configured in configuration windows for each channel.
The module checks for overflow depending on the selected range and verifies that the measurement falls 
between a lower and an upper threshold:

Function Normal Cycle Fast Cycle
Analog input 6.5 ms 1.3 ms + (1.3 ms x N)

where N: number of channels in use.

Designation Description
Nominal range Measurement range corresponding to the chosen range
Upper Tolerance Area Varies between the values included between the maximum value for the range (for instance: 

+10 V for the ±10 V range) and the upper threshold
Lower Tolerance Area Varies between the values included between the minimum value for the range (for instance: 

-10 V for the ±10 V range) and the lower threshold
Overflow Area Area located beyond the upper threshold
Underflow Area Area located beyond the lower threshold
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Analog Input Function
The threshold values are configurable independently from one another. They may assume integer values 
between the following limits:

Measurement Display
Measurements may be displayed using standardized display (in %, to two decimal places):

It is also possible to define the range of values within which measurements are expressed, by selecting:
 The lower threshold corresponding to the minimum value for the range: 0 % (or -100.00%).
 The upper threshold corresponding to the maximum value for the range (+100.00%).
The lower and upper thresholds must be integers between -32,768 and +32,767.
For example, imagine a conditioner providing pressure data on a 4…20 mA loop, with 4 mA corresponding 
to 3,200 millibar and 20 mA corresponding to 9,600 millibar. You have the option of choosing the User 
format, by setting the following lower and upper thresholds:
 3,200 for 3,200 millibar as the lower threshold
 9,600 for 9,600 millibar as the upper threshold
Values transmitted to the program vary between 3,200 (= 4 mA) and 9,600 (= 20 mA).

Measurement Filtering
The type of filtering performed by the system is called first order filtering. The filtering coefficient can be 
modified from a programming console or via the program.
The mathematical formula used is as follows:
Measf(n) = α x Measf(n-1) + ( 1-α ) x Valb(n)

where:
α = efficiency of the filter
Measf(n) = measurement filtered at moment n

Measf(n-1) = measurement filtered at moment n-1

Valb(n) = gross value at moment n

You may configure the filtering value from seven possibilities (from 0…6). This value may be changed even 
when the application is in RUN mode.
NOTE: Filtering may be accessed in Normal or Fast Cycle.

NOTE: α=e-Tcycle/τ

Range Range
Underflow Area Lower Tolerance 

Area
Nominal Range Upper Tolerance 

Area
Overflow Area

Unipolar
0…10 V -1,400 -1,001 -1,000 -1 0 10,000 10,001 11,000 11,001 11,400
0...5 V/0...20 mA -5,000 -1,001 -1,000 -1 0 10,000 10,001 11,000 11,001 15,000
1...5 V/4...20 mA -4,000 -801 -800 -1 0 10,000 10,001 10,800 10,801 14,000
Bipolar
±10 V -11,400 -11,001 -11,000 -10,001 -10,000 10,000 10,001 11,000 11,001 11,400
±5 V, ±20 mA -15,000 -11,001 -11,000 -10,001 -10,000 10,000 10,001 11,000 11,001 15,000
User
±10 V -32,768 - - - User-

defined
User-
defined

- - - 32,767

0...10 V -32,768 - - - User-
defined

User-
defined

- - - 32,767

Type of Range Display
Unipolar range
 0…10 V, 0…5 V, 1…5 V, 0...20 mA, 4…20 mA

From 0...10,000 (0% at +100%)

Bipolar range
 ±10 V, ±5 V, ±20 mA 

From -10,000…10,000 (-100% at +100%)
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where:
Tcycle = sampling period of the channel
τ = response time of the filter
The relation between the efficiency α and the Parameter k (0 to 6) is:
α = 0 for k=0

α = 1-1/2k+1 for k=1...6
The filtering values depend on the T configuration cycle (where T = cycle time of 6.5 ms in standard mode):

NOTE: Enter the valid value for filter between the ranges 0…6. If you enter an invalid value in Device DDT, 
MC80 PLC will consider the last value of the filter.

Sensor Alignment
The process of alignment consists in eliminating a systematic offset observed with a given sensor, around 
a specific operating point. This operation compensates for an error linked to the process. Replacing a 
module does not therefore require a new alignment. However, replacing the sensor or changing the 
sensor’s operating point does require a new alignment.
Conversion lines are as follows:

The alignment value is editable from a programming console, even if the program is in RUN Mode.
For each input channel, you can:
 view and modify the desired measurement value
 save the alignment value
 determine whether the channel already has an alignment
The alignment offset may also be modified through programming. Channel alignment is performed on the 
channel in standard operating mode, without any effect on the channel’s operating modes.
The maximum offset between measured value and desired (aligned) value may not exceed ±1,500.
NOTE: To align several analog channels, we recommend to proceed channel by channel. Test each 
channel after alignment before moving to the next channel in order to apply the parameters correctly.
NOTE: Enter the valid value for the filter. The valid value is between the predefined ranges. If you enter an 
invalid value in Device DDT, MC80 PLC will consider the upper or lower limit from the predefined range.

Desired Efficiency Required Value Corresponding α Filter Response Time 
at 63%

Cut-off frequency 
(Hz)

No filtering 0 0 0 -
Smooth filtering 1 0.750 4* T 0.040/T

2 0.875 8* T 0.020/T
Average filtering 3 0.937 16* T 0.010/T

4 0.969 32* T 0.005/T
High filtering 5 0.984 64* T 0.0025/T

6 0.992 128* T 0.0012/T
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Wiring Precautions
In order to protect the signal from outside interference induced in series mode and interference in common 
mode, we recommend that you take the following precautions:
 Cable Shielding - Connect the cable shielding to the grounding bar. Clamp the shielding to the 

grounding bar on the module side.
For more details on grounding, refer to the chapter Grounding Bar  (see page 77).

Electromagnetic Hazard Instructions

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH
While mounting / removing the modules:
 Make sure that each terminal block is still connected to the grounding bar
 Disconnect voltage supplying sensors and pre-actuators.
Failure to follow these instructions will result in death or serious injury.

WARNING
UNEXPECTED EQUIPEMENT OPERATION
 Use a 24 Vdc supply to sensors and a shielded cable for connecting the sensors to the module.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

DANGER
HAZARD OF ELECTRIC SHOCK
Sensors and other peripherals may be connected to a grounding point some distance from the module. 
Such remote ground references may carry considerable potential differences with respect to local 
ground. Ensure that:
 potentials greater than permitted low limits cannot exist,
 induced currents do not affect the measurement or integrity of the system.
Failure to follow these instructions will result in death or serious injury.

CAUTION
UNEXPECTED BEHAVIOR OF APPLICATION
Follow these instructions to reduce electromagnetic perturbations:
 Use the BMX XSP 0400/0600/0800/1200 electromagnetic protection kit to connect the shielding.
Electromagnetic perturbations may lead to an unexpected behavior of the application.
Failure to follow these instructions can result in injury or equipment damage.
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Analog Input Function
Wiring Diagram
The Analog Input Function is connected using the 20-pin terminal block (BMXFTB20x0).
This figure shows the terminal block connection and the sensor wiring:

IVx: pole input for channel x
COM: common pin for each channel
ICx: current reading resistor + input
FG functional ground

This table lists the suitable terminal block references for AnaIog Input function:

I/O Function Reference Number
AnaIog Input function BMX FTB 2000

BMX FTB 2010
BMX FTB 2020
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Analog Input Function
LED Indicator
The LED indicator shows the status of the AI channels.

Use this table to perform diagnostics of the analog input function status according to the channel LEDs: 

For more information, refer to “Fitting a 20-Pin Terminal Block”  (see page 35).

Status LEDs AMI Function Function Status
IN Channel
ON Operating normally
OFF Module is running with channels in stopped state
OFF Module is inoperative or turned off
OFF Module not configured or channel configuration in progress
OFF Internal error in module
OFF Not configured
BLK Range under/overflow error
FLK Sensor link error
Legends
ON LED is turned on
OFF LED is turned off
FLK (Flickering) The LED is turned on for 50 ms then turned off for 50 ms, and then repeat
BLK (Blinking) The LED is turned on for 200 ms then turned off for 200 ms, and then repeat
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Chapter 8
High Speed Counting Input and Output Function

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
High Speed Counting Input and Output Function 58
Display and Diagnostics of the High Speed Counting Function 60
HSC Function Wiring 61
Fitting a 28-Pin Terminal Block 63
28-Pin Terminal Block Modules 64
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High Speed Counting Input and Output Function
High Speed Counting Input and Output Function

Description
The MC80 PLC’s High Speed Counting Input and Output (HSC I/O) function is an equivalent function like 
M340 EHC0200, which is compatible with the Control Expert software and operates up to 60 kHz.
The function provides two channels and each channel provides six digital inputs and two digital outputs 
and contains programmable blocks.
The counter operates in one of nine user-configurable modes, which may be selected by using the Control 
Expert configuration tool.
This HSC I/O function is available on the BMK C80 30311 PLC.

General Characteristics
The following table shows the general characteristics of the HSC I/O function:

Input Characteristics
The following table lists general characteristics of the input channels for the function:

Characteristic Description Value
Function type 2 counting channels
Maximum frequency at counting inputs 60 KHz
Counting depth 32 bits
Number of digital inputs/outputs per 
counting channel

Inputs 3 fast inputs 24 Vdc Type 1
3 normal inputs 24 Vdc Type 3

Outputs 2 outputs 24 Vdc
Power supply Sensor power voltage 19...30.0 Vdc

Sensor power current (12 inputs on) Typical 70 mA
Maximum 77 mA

Sensor power supply reverse polarity 
protection

Yes, by reverse-mounted diode. Use 
an external fast blow fuse.

Pre-actuator power supply (without 
load current)

Typical 15 mA
Maximum 20 mA

Pre-actuator power supply reverse 
polarity protection

Yes. By reverse-mounted diode. Use 
an external fast blow fuse.

Actuator power current 0.625 A maximum per output
Power distribution to sensors Yes with short-circuit and overload 

protection. Typical 300 mA (short-
circuit limited to 2.5 A)

Encoder compliance Complies with most encoders that 
have a supply of between 15 V and 30 
V and push-pull outputs

Insulation voltage of the ground to the bus 1,500 V rms for 1 minute

Characteristic Description
Number of input Channels Six 24 Vdc inputs per counting channel
IN EN, IN REF, IN CAP Maximum input voltage 30 Vdc continuous

On input voltage +11…+30 Vdc
Off input voltage up to +5 Vdc
Off input current up to 1.5 mA
On input current (Up to 30 Vdc) 5 mA
Current at 11 Vdc >2 mA
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Output Characteristics
The following table lists the general characteristics of the output channels for the function:

NOTE: The two paralleled channels have to be controlled simultaneously in Control Expert application to 
avoid overload on one channel.

IN A, IN B, IN SYNC Maximum input voltage 30 Vdc continuous
On input voltage +15…+30 Vdc
Off input voltage up to +5 Vdc
Off input current up to 1.5 mA
On input current (Up to 30 Vdc) 5 mA
Current at 15 Vdc >2 mA

Input response time Refer to the input filter and bounce filter tables.
Sensor power supply monitor Ok >19 V (max.)

Fault <14 V (typ.)

Characteristic Description

Characteristic Description
Number of outputs per channel 2
Type 24 Vdc transistor source
Output voltage 19...30.0 Vdc
Maximum load current Each point 0.625 A

Output group 2.5 A
Off state leakage/point <0.5 mA
On state output voltage drop <1.2 V
Short circuit output current At each point current limited at 0.7 A<Id<1.7 A, after internal over-temperature 

is detected.
Maximum load capacity 50 µF
Maximum inductive load The inductive load is calculated using the following formula:

L = 0.5/I² x F
where:
L = load inductance (Henry)
I = load current (A)
F = switching frequency (Hz)

Maximum response time <600 µs
Output protection (internal) Transient voltage suppression
Short circuit Protection/status per channel. Overload/short-circuit is reported only when 

consequent over-temperature happens on output drivers.
Fallback value (output channels) Default Predefined fallback values on both 

channels
User-configurable settings Hold last value

Predefined fallback value on one or 
both channels

Fallback states for output channels 
(when predefined is the fallback 
mode)

Default Both channels go to 0
User-configurable settings Each channel configurable for 1 or 0

Polarity on individual output channels Default Logic normal on both channels
User-configurable settings Logic reverse on one or both channels

Logic normal on one or both channels
Pre-actuator power supply monitor OK >19 V (max.)

Error <14 V (typ.)
Output paralleling Yes (2 channels maximum and total 1 A maximum)
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Display and Diagnostics of the High Speed Counting Function

Description
The HSC counting module has LEDs that enable the status of the module to be viewed.
The LEDs for inputs/outputs of each channel are:
 State LED for inputs of each channel: IA, IB, IS, IE, IP, IC.
 State LED for outputs of each channel: Q0, Q1.

Representation
The below figure shows the LED indicator of the HSC function: 

Function Diagnostics
The following table presents the various function states according to the LED states (empty cell indicates 
that the pattern on the associated LED can be ignored):

LED indicators Function Status
IA IB IS IE IP IC Q0 Q1
BLK - - - Sensor supply fails
- - - - - - BLK Actuator supply fails
- - - - - - FLK - OUT 0 has a Short Circuit
- - - - - - - FLK OUT 1 has a Short Circuit
ON - - - - - - - The voltage is present on IA
- ON - - - - - - The voltage is present on IB
- - ON - - - - - The voltage is present on IS
- - - ON - - - - The voltage is present on IE
- - - - ON - - - The voltage is present on IP
- - - - - ON - - The voltage is present on IC
- - - - - - ON - The voltage is present on Q0
- - - - - - - ON The voltage is present on Q1
Legends
ON LED is turned on
OFF LED is turned off
FLK (Flickering) The LED is turned on for 50 ms then turned off for 50 ms
BLK (Blinking) The LED is turned on for 200 ms then turned off for 200 ms
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HSC Function Wiring

Description
The MC80 PLC's HSC IO function is connected using the 28-pin terminal block (BMXFTB28x0).

Assignment of the 28-Pin Connector
The below figure shows the physical location of the pin numbers for the 28-pin connector:

The symbol and description of each pin are described in the table below:

DANGER
HAZARD OF ELECTRIC SHOCK
 Disconnect voltage supplying sensors and pre-actuators before plugging/unplugging the terminal 

block on the module.
 Remove the terminal block before plugging/unplugging the module on the rack.
Failure to follow these instructions will result in death or serious injury.

Pin Number Symbol Description
2,12 24V_SEN 24 Vdc output for sensors supply
1,11 GND_SEN 24 Vdc output for sensors supply
9,10,19,20 FG Functional ground
4,14 IN_A_0 IN_A_1 Input A
6,16 IN_B_0 IN_B_1 Input B
3,13 IN_SYNC_0 IN_SYNC_1 Synchronization input
5,15 IN_EN_0 IN_EN_1 Enable input
8,18 IN_REF_0 IN_REF_1 Homing input
7,17 IN_CAP_0 IN_CAP_1 Capture input
22 24V_IN 24 Vdc input for sensors supply
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The following table lists the suitable terminal block references for High Speed Counting function:

21 GND_IN 24 Vdc input for sensors supply
23 Q0-0 Q0 output for counting channel 0
24 Q0-1 Q1 output for counting channel 0
25 Q1-0 Q0 output for counting channel 1
26 Q1-1 Q1 output for counting channel 1
28 24V_OUT 24 Vdc input for actuators supply
27 GND_OUT 24 Vdc input for actuators supply

I/O Function Reference Number
Hight Speed Counting function BMX FTB 2800

BMX FTB 2820

Pin Number Symbol Description
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Fitting a 28-Pin Terminal Block

Installing the 28-Pin Terminal Block
The following table shows the assembling of the 28-pin terminal block onto I/O functions tightening torque 
0.4 N•m (0.30 lb-ft):

NOTE: If the screws are not tightened, the terminal block may not be properly fixed to the module.
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High Speed Counting Input and Output Function
28-Pin Terminal Block Modules

At a Glance
The High Speed Counting function is supplemented by a 28-pin terminal block.
There are two types of 28-pin terminal blocks:
 BMX FTB 2820 spring terminal blocks.
 BMX FTB 2800 caged terminal blocks.

Cable Ends and Contacts
The terminal block can accommodate:
 Bare wires

 Wires with DZ5-CE type cable ends: 

Description of the 28-Pin Terminal Blocks
The table below shows the description of the 28-pin terminal blocks:

Spring terminal blocks Caged terminal blocks
Illustration

Number of wires accommodated 1 1
Number of wire gauges 
accommodated

minimum 0.25 mm2 (AWG 24)
maximum 1.5 mm2 (AWG 16)

Wiring constraints The wires are connected by pressing on the 
button located next to each pin. To press on the 
button, you have to use a flat-tipped screwdriver 
with a maximum diameter of 3 mm.

Caged terminal blocks have slots that accept:
 flat-tipped screwdrivers with a diameter of 3 

mm,
 posidriv n° 1 cross-tipped screwdrivers.

Caged terminal blocks have captive screws. On 
the supplied blocks, these screws are not 
tightened.

Maximum screw tightening torque - 0.5 N•m (0.37 lb-ft).
Temperature range of wire Minimum 105 °C

DANGER
ELECTRICAL SHOCK
The terminal block must be connected or disconnected with sensor and pre-actuator voltage switched off.
Failure to follow these instructions will result in death or serious injury.
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High Speed Counting Input and Output Function
Labeling of 28-Pin Terminal Blocks
Labels for the 28-pin terminal blocks are supplied with the module. They are to be inserted in the terminal 
block cover by the customer.
Each label has two sides:
 One side that is visible from the outside when the cover is closed. This side features the commercial 

product references, an abbreviated description of the module, as well as a blank section for customer 
labeling.

 One side that is visible from the inside when the cover is open. This side shows the terminal block 
connection diagram.

Sensor Connections
The example below shows three-wire input devices used on inputs IN_A and IN_B and two-wire devices 
used on inputs IN_EN and IN_SYNC:

1 IN_A input
2 IN_B input
3 IN_SYNC input (synchronization input)
4 IN_EN input (enable input)

Encoder Connection
The example below shows an incremental encoder used for axis control and the three auxiliary inputs used 
especially for largest mode (Free Large Counting):

1 Encoder (inputs A, B and Z)
2 IN_REF input (homing input)
3 IN_EN input (enable input)
4 IN_CAP input (capture input)
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Connecting Outputs and Output Supplies
The figure below shows the connection of supplies and actuators to the 28-pin connector:

1 24 V supply for actuators
2 24 V supply for sensors
3 Actuator for the Q0 output of counting channel 0
4 Actuator for the Q1 output of counting channel 0
5 Actuator for the Q0 output of counting channel 1
6 Actuator for the Q1 output of counting channel 1
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Communication

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Communication 68
Serial Link 69
Ethernet Link 71
CANopen Link 74
USB Link 76
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Communication

Description
The communication functions available in MC80 controller are:
 Serial link
 Ethernet port
 CANopen link

Representation

1 Rotary switches
2 Ethernet ports
3 Serial link
4 CANopen link
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Communication
Serial Link

Description
Serial link is a communication protocol in which the serial port can be configured as RS485 or RS232 by 
Control Expert. The serial link is used for connecting the HMI, modem, and other serial devices.
The following table describes the characteristics of the serial communication channels:

The following table shows the specification of Modbus link:

The following figure shows the LED indicator of the Serial Communication:

The following table lists the definition of the LED indicator:

The following table describes the LED pattern and the indication:

Characteristic Description
Protocols supported  Modbus protocol (RTU and ASCII)

 Character mode protocol

Connection Shielded RJ45 connector
Physical link  RS485 non-insulated serial link

 RS232 non-insulated serial link

Characteristic Description Value
Serial link physical 
spec.

Baud Rate 300…19,200 bps
Connector type Shielded RJ45
Interface RS232, RS485 software configurable
Connection Media 2-wire RS485

RS232 with or without RTS, CTS handshaking signals.
Mode of Operation Master/Slave
Polarization Software configurable polarization on RS485 in character mode.
RS232 type DTE
5 Vdc output power Voltage tolerance: ±10%

Maximum current: 190 mA
Max. cable length RS232: 15 m

RS485: 
 10 m non-isolated link 
 1,000 m isolated link

(For an isolated link, the TWD XCA ISO isolation box must be used.)

Label Color Description
SER COM Yellow Indicates the communication activity of serial link

LED Pattern Indication
SER COM (yellow): 
serial data status

flashing Data exchange on the serial connection is in progress (receiving or sending)
off No data exchange on the serial connection
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Representation
The following figure shows the RJ45 serial port:

The below table lists the pin assignment of RJ45 connector:

NOTE: The RS232 4-wire, RS485 2-wire, and power supply cables all use the same RJ45 connectors. 
MC80 PLC can use TWDXCAISO module as an isolation solution.

RJ45 Pin No. RS232 Signal Name RS485 Signal Name
1 RXD Reserved
2 TXD Reserved
3 RTS Reserved
4 Reserved D1
5 Reserved D0
6 CTS Reserved
7 5 V output 5 V output
8 GND GND
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Ethernet Link

Description
The MC80 PLC have two Ethernet ports dedicated to Ethernet communication with two rotary switches 
which enable easy selection of the IP address.
The following table shows the specification of the Ethernet link:

The figure below shows the LED indicator of the Ethernet Communication:

The following table lists the definition of the LED indicators:

The ETH STS is located on the ETH led panel.
The following table describes the LED pattern and the indication:

Characteristic Description Value
Di-electric strength Ethernet 1,500 Vdc between logic common and twisted pair (@0…2,000 m 

altitude).
Ethernet port 
physical spec.

Connector Type Dual shield RJ45 connectors
Speed 10Base-T, 100Base-TX
Auto Negotiation Supported
Auto MDI/MDI-X Supported
Addressing Unique IEEE Global (MAC) Address. User assigned IP Address
Mode of Operation Master/Slave, Half/Full duplex
Topology Star, Daisy chain
Media Copper (Twisted pair)
Isolation support Yes

Label Color Description
ETH STS Green Indicates the Ethernet port operation states

LED Pattern Indication
ETH LNK/ACT (green) on Ethernet link is detected and there is no communication activity

off No Ethernet link is detected
Flashing Data exchange on the Ethernet link is in progress

ETH 100 green Ethernet transmission is at 100 Mbits/s (Fast Ethernet)
yellow Ethernet transmission is at 10 Mbits/s
off No link is detected

ETH STS (green): Ethernet 
communication status

off No communication activity
on Communication is OK
2 flashes Invalid MAC address
3 flashes Ethernet link is not connected
4 flashes Duplicate IP Address
5 flashes Waiting for server IP address
6 flashes Safe Mode - At default IP address
7 flashes Configuration conflict between rotary switches and internal configuration
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Communication
The below figure shows the LED indicator of the Ethernet Communication (connector): 

The following table lists the definition of the embedded LED on the RJ45 connector:

Representation
The following figure shows the RJ45 Ethernet port:

The following table lists the pin assignment of the RJ45 Ethernet port:

Rotary Switches
The purpose of the two rotary switches is to select an IP address. To set an IP address, rotate the arrow 
firmly into the desired position.
NOTE: If you do not feel the switch click into place, the value of the switch may be incorrect or 
undetermined.

Label Color Description
ETH1 ACT Green Indicates the activity of Ethernet port1
ETH1 10/100 Green Indicates the speed of Ethernet port1 which is 100 Mbps

Yellow Indicates the speed of Ethernet port1 which is 10 Mbps
ETH2 ACT Green Indicates the activity of Ethernet port2
ETH2 10/100 Green Indicates the speed of Ethernet port2 which is 100 Mbps

Yellow Indicates the speed of Ethernet port2 which is 10 Mbps

Pin No. Signal Name
1 TD+
2 TD-
3 RD+
4 Not connected
5 Not connected
6 RD-
7 Not connected
8 Not connected
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Switch Settings
This table describes the switch settings:

NOTE: The selection on the lower switch of any non-numeric parameter (DHCP, STORED, CLEAR IP, 
DISABLED) makes the setting on the upper switch inconsequential.
NOTE: Make sure to restart the PLC after changing the rotary switch position. 

Rotary Switch Numbers Description
Upper switch 0…9 Tens value for the device name (0, 10, 20, …, 90)

10(A)…15(F) Tens value for the device name (100, 110, 120, …, 150)

Lower switch 0…9 Ones value for the device name (0, 1, 2, …, 9)
DHCP Set the lower rotary switch to one of its DHCP positions to perform a DHCP request that has a 

MAC address as Client Identify.
Stored The lower rotary switch is set to STORED (default setting) to use the application’s configured 

parameters.
 Configure static IP
 Configure Device Name to get IP address through DHCP

NOTE: When the Device Name is empty, MC80 will use MAC address to get IP address.

Clear IP The lower rotary switch is set to CLEAR IP to use the MAC-based default IP address.
The default IP address format is 10.10.x.x
 10.10: is a fixed value
 x: The last two fields in the default IP address are composed of the decimal equivalents of 

the last two hexadecimal bytes in the MAC address.
Disabled Set the switch to Disabled to disable communications.

Device Name Naming Rules
There are three components of the device name. The default device name of the module is:
BMK C80 20310 : BMK_20310_xxy
The numeric value between 00 and 159 is set on the rotary switches. (For the default device name, xx is the value of the upper rotary switch 
and y is the value of the lower rotary switch.)
For example: For a BMK C80 20310 module, values of 120 (12 x 10) and 6 (6 x 1) on the respective upper and lower rotary switches indicate 
a value of 126. The value is appended to the default device name (BMK_20310_xxy) to create the valid DHCP device name of 
BMK_20310_126.
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CANopen Link

Description
The CANopen port is a built-in communication channel dedicated to CANopen communication. The 
CANopen port of the processor module is fitted with a SUB-D9 connection.
The following table shows the specification of the CANopen link:

The following figure shows the LED indicator of the CANopen Communication:

The following table lists the definition of the LED indicators:

NOTE: The priority of CANopen led status is: on > 2 flashes > 1 flash > flashing > off. 
The following table describes the LED pattern and the indication:

Characteristic Description Value
Di-electric strength CANopen 500 Vac or 700 Vdc between logic common and CANopen 

(@0…2,000 m altitude).
CANopen physical spec. Type Master

Address range 1…16 (16 slaves max. on the CPU)
Baud Rate 1 Mbps, 500 kbps, 250 kbps, 125 kbps, 50 kbps, 20 kbps
Connector type Shielded D-SUB 9
Isolation support Yes

Label Color Description
CAN RUN Green Indicates the CANopen operation status
CAN ERR Red Indicates the detected errors on CANopen

LED Pattern Indication
CAN RUN (green): 
CANopen operation

on CANopen network is operational
slow flashing (on for 200 
ms, off for 200 ms, 
repeating)

CANopen network is pre-operational, or master being alone

1 flash CANopen network is stopped
off CANOpen is not configured

CAN ERR (red): CANopen 
detected errors

on  CANopen bus is stopped, CAN controller has status 
"BUS OFF"

 Not configured

slow flashing (on for 200 
ms, off for 200 ms, 
repeating)

 CANopen configuration is not valid
 Invalid configuration
 Logic configuration is different from physical 

configuration. For example, missing or different slaves 
are detected.

1 flash One of the detected error counters has reached or exceeded 
the alert level

2 flashes A heartbeat event has taken place
off No CANOpen error
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Representation
The following figure shows the CANopen port and the pin labels:

The following table lists the pin assignment of CANopen port:

Pin No. Signal Name
1 Reserved
2 CAN_L
3 CAN_GND
4 Reserved
5 Reserved
6 GND
7 CAN_H
8 Reserved
9 Reserved
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Communication
USB Link

Description
The USB port is a default terminal connection for application download/upload, programming tool (Control 
Expert) connection and so on. The USB port is USB 2.0 type which uses a mini-B type shield connector.
The following table shows the specification of the USB link:

Representation
The following figure shows the USB port and the pin labels:

The below table lists the pin assignment of USB port:

NOTE: To avoid unexpected behavior of the PLC, always use one of the following shielded cable USB that 
comply the international standard:
 BMX XCA USB 018
 BMX XCA USB 045

Characteristic Description Value
USB physical spec. Type USB 2.0 Device

Speed mode Full speed mode (12 Mbps)

Pin No. Signal Name
1 VBUS
2 DM
3 DP
4 Reserved
5 Ground
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Chapter 10
Grounding of PLC

Grounding of PLC

Description
The grounding of MC80 PLC is important to avoid electric shock and the configuration involves the 
grounding screw and power supply terminal.

Grounding the Protective Earth (PE) terminal of PLC
Protective grounding must be performed by connecting the grounding screw located on the left-hand side 
of the product to the earth of installation.
Two cables of ø3 mm maximum can be connected using grounding screw.

Grounding the Power Supply Terminal (FG)
The Functional Ground (FG) located on the power supply must be connected to the earth of installation in 
one of the following two ways:
 Using a separate cable that is independent of the Protective Earth, and directly connected to the earth 

of installation.
Or

 Using a cable that connects the Protective Earth (PE) terminal.

Representations
The following figure shows the ground connection between grounding screw and FG of power supply using 
two independent ground cables.

1 Grounding Screw (Maximum tighten torque: 1.5 N•m (1.1 lb-ft))
2 Power Supply Terminal Block
3 Earth of installation

WARNING
UNINTENDED EQUIPMENT OPERATION
Tighten the clamping screws of the modules. A break in the circuit could lead to an unexpected behavior 
of the system.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

DANGER
HAZARD OF ELECTRIC SHOCK
Power supply terminal must be grounded. Do not connect anything else to the power supply ground.
Failure to follow these instructions will result in death or serious injury.
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Grounding of PLC
The following figure shows the ground connection between grounding screw and FG of power supply.

1 Power Supply Terminal Block
2 Grounding Screw (Maximum tighten torque: 1.5 N•m (1.1 lb-ft))
3 Earth of installation

Grounding Bar
To guarantee protection against electromagnetic interferences, the cable shielding is directly connected to 
the ground.
NOTE: The cable shielding is not connected to the module shielding.
This connection can be made using any method but a protection bar is provided in order to facilitate the 
set up.
A protection bar is used in two cases:
 counting module with 28-pin terminal blocks
 analog module with 20-pin terminal block
The STB grounding bar references are listed below:

Each kit includes the following components:
 one grounding bar
 side brackets
 one set of spring locking clamp rings to fasten the cables to the protection bar

DANGER
HAZARD OF ELECTRIC SHOCK
Use only cables with ring or spade lugs to ensure connection to ground. Ensure grounding hardware is 
tightened properly.
Failure to follow these instructions will result in death or serious injury.

Reference Description
STBXSP3000 SHD KIT BRACKETS AND BAR
STBXSP3020 QTY10 SHD KIT SIZE 2 WIRE CLAMP (for fastening analog and counting modules connection 

cables)
78 EIO0000002071 06/2020



Grounding of PLC
The following figure shows a grounding bar fastened to DIN rail Hook:

1 DIN rail Hook
2 Grounding bar
3 FG grounding clamp
4 DIN rail Hook
5 Side brackets
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What Is in This Chapter?
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Operating Standards and Conditions
Standards and Certifications

Description
The Modicon MC80 PLCs are designed to comply with the relevant standards or rules related to an 
electrical equipment as PLCs for the industrial use.

Standards and Certifications
Introduction
MC80 PLCs have been designed to comply with the relevant standards and rules for electrical equipment 
in an industrial automation environment.
Industrial Standards
Requirements specific to the PAC functional characteristics, immunity, robustness, and security:
 IEC/EN 61131-2 Ed 3, completed by IEC 61010-2-201
 CSA-E 1131-2
 UL 61010-2-201
European directives for EC Marking:
 low voltage: 2006/95/EC
 electromagnetic compatibility: 2004/108/EC
Installation in Classified Ex Area
 Hazardous locations class I, division 2, groups A, B, C, and D according to CSA 22.2 No.213
Specific Countries
 For Australia and New Zealand: ACMA requirements for RCM marking

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION
Disconnect all power before removing components, if installed in a hazardous location where flammable 
gases or combustible dusts may be present. Electrical sparks in a hazardous location will cause an 
explosion.
Failure to follow these instructions will result in death or serious injury.
82 EIO0000002071 06/2020



Operating Standards and Conditions
Operating Conditions

Operating Temperature/Hygrometry/Altitude
These are the operating conditions relative to the outside environment:

Characteristic Value
Temperature Operating -25…70 °C

Storage -40…85 °C
Humidity Max. 93% (non-condensing) at 70 °C
Altitude  0...2,000 m: full specification for temperature and isolation

 2,000…5,000 m:
 temperature de-rating: -1 °C/400 m

 isolation loss: -150 Vdc/1,000 m
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Part III
MC80 Software Implementation

What Is in This Part?
This part contains the following chapters:

Chapter Chapter Name Page
12 Configuration of MC80 87
13 MC80 Firmware Upgrade 151
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Chapter 12
Configuration of MC80

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Configuration of Modicon MC80 Processors 88
Connecting to MC80 91
IO Configuration 92
Configuring the Serial Port of the CPU 111
Modbus Serial communication 114
Character Mode Communication 119
Configuring the Ethernet Port of the CPU 123
CANopen Configuration 132
System Bits and Words 141
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Configuration of MC80
Configuration of Modicon MC80 Processors

Enable MC80
The following table describes the steps to enable MC80 in Unity Pro 8.1 or later:

Access to the Configuration Screen
The following table describes the steps to access the configuration screen: 

Step Action
1 Install Unity 8.1 or later.
2 Install the Hot fix: UnityPro_V81_HF_MC80
3 Create a new project with MC80.

Step Action
1 Select the processor.

2 Using the contextual menu, click Open.
3 Select the Configuration tab.
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Configuration of MC80
Configuration of the Processor
NOTE: You can modify the parameters of this dialog box only in offline mode.
The following screen shows the MC80 CPU configuration screen:

In the configuration screen, proceed with the following steps:

CAUTION
LOSS OF DATA ON APPLICATION TRANSFER
Press the RESET button on the power supply. Otherwise, %MWi is reset and initial values are loaded.
Failure to follow these instructions can result in injury or equipment damage.

Step Action
1 Enable the Run/Stop input option, if required.

Do not enable this option if the associated discrete input is mapped because this inhibits the PLC start-up.
2 Enable the Memory protect  option, if required.

The protection is activated by an input bit. It prohibits the transfer of a project into the PLC and modifications 
in online mode, regardless of the communication channel. The Run and Stop commands are authorized.

3 Enable the Automatic start in Run option, if required.
4 Confirm whether the internal words %MWi are to be initialized on cold start triggered by software (application 

download, initialize command, restore command, %S0 activation, cold start button on the PLC screen) or 
not. By checking the box, the PLC writes the initial values to %MWI.

5 Enable the Cold Start Only option, if required.
6 In the Size of global address fields of the dialog box define for the application the number of internal bits %M.
7 Define the number of internal words %MW.
8 Define the number of constants %KW.
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Configuration of MC80
The following table shows the different elements of configuration screen and their functions:

Element Function
Operating mode
Operating mode Operating mode zone includes the following elements:

 Run/Stop input
 Memory protect
 Automatic start in Run
 Initialize %MWi on cold start
 Cold Start Only

Run/Stop Run/Stop input can be:
 the image value of a physical digital input: MOD_DIS_16_1.DIS_CH_IN[i].VALUE, where i = 

number from 0…7
 an unlocated variable of type BOOL with correct RW Program (for example, MyRunStop1)
 an unlocated variable of type EBOOL with correct RW Program (for example, MyRunStop2)

The Run/Stop by input only parameter is significant only if the Run/Stop input is valid.
If the Run/Stop by input only is unchecked it is possible to change the PLC state from Run 

to Stop (or the opposite) either with a Run/Stop 
Request or by changing the value of the 
Run/Stop input.

If the Run/Stop by input only is checked it is only possible to change the PLC state from 
Run to Stop (or the opposite) by changing the 
value of the Run/Stop input.

NOTE: Before downloading a different 
application, reset the Run/Stop input to 0 or 
press the reset button.

Memory protect Memory protect follows the same rules as Run/Stop input.
When you configure and enable memory protect, you cannot change the PLC configuration or 
application and upload the application.

Initialize %MWi 
on cold start

On a cold start or on download if you check the 
box (default state)

the %MWi are handled like other global 
variables (initialized to 0 or initial value, 
according to current application) in all cold start 
cases.

On cold start or on download if you uncheck the 
box

if %MW were previously saved in internal flash 
memory (using the %SW96 word) they are 
restored from internal flash memory
if not,
 if cold start is linked to a push on the reset 

button, the %MW are initialized.
 if not, the current values of %MW are 

maintained.

NOTE: if the new (or restored) application has more %MW than the previous one, the added %MW 
are set to 0 (non-zero initial values are not applied).

Cold Start Only If checked, this option forces the cold start of the application, instead of the normal warm start.
By default, the Cold Start Only option is unchecked.
An application using this functionality is not:
 downloadable on a PLC with a previous version,
 executable on a PLC with a previous version.

If cold start only is checked and run/stop is configured on unlocated variable, then the PLC will 
restart in run or stop, depending on an initial value of the variable. It does not restart in the same 
state as before.

Memory Management
Memory 
Management

It includes the Size of global address fields (%M, %MW, %KW, %S, %SW)

CAUTION
UNINTENDED EQUIPMENT OPERATION
At the end of download, the PLC starts automatically if the default value of a user-defined unlocated 
Run/Stop variable is 1.
Failure to follow these instructions can result in injury or equipment damage.
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Configuration of MC80
Connecting to MC80

Description
MC80 is password protected to avoid unwanted application modification and download. A password is 
required to open the application and connect to MC80.

Creating a Password
Follow the steps below for creating the password:

NOTE: You should enter the password to open the application and connect to MC80.

Step Action
1 In the project browser, right-click Project.
2 Select Properties command from the pop-up menu.

Result: The Properties of Project window appears.
3 Select Protection tab.
4 In the Application field, click Change password ....

Result: The Modify Password window appears.
5 Enter the new password in the Entry field.
6 Enter the confirmation of the new password in the Confirmation field.
7 Click OK to confirm.
8 Click OK or Apply in the Properties of Project window to confirm all changes.

If you click Cancel in the Properties of Project window, all changes are canceled.
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Configuration of MC80
IO Configuration

Digital IO Function Channels
The various available screens for the discrete functions are:
 Configuration screen
 Type
The following screen shows MC80 Digital IO 8 Input 8 Output functions configuration screen:

The following screen shows MC80 Digital IO 8 Input 12 Output functions configuration screen:
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Configuration of MC80
The following table shows the various elements of the configuration screen and their functions:

Task Parameter
This parameter defines the processor task MAST where input acquisitions and output updates are 
performed.

External Power Supply Error Monitoring Parameter
The following table shows how to disable or enable the external power Supply monitoring function:

NOTE: The external power supply monitoring function is not available for channel 0…7.

Address Element Function
1 Tabs The tab in the foreground indicates the mode in progress (Configuration in this 

example). Every mode can be selected using the respective tab:
 Overview
 Configuration
 Device DDT which gives the Device DDT name and type of the device

2 Module area Specifies the abbreviated heading of the module.
3 Channel area Allows you:

 to click the reference number, to display the tabs:
 Description which gives the characteristics of the device

 to select a channel
 to display the Symbol, name of the channel defined by the user (using the variable 

editor)

NOTE: All channels are activated and a channel cannot be de-activated to None.

4 General 
parameters area

Allows you to select the associated function and task in groups of 8 channels:
 Function: Defines the configuration/de-configuration of the channel group selected 

(other than groups 0…7)
 Task: Defines the task (MAST) in which channel default exchange objects will be 

exchanged
The Supply monitoring check box defines the active or inactive state of the external 
power supply monitoring.
The Reactivate and Fallback mode drop-down menus enable you to configure the 
output reset and output fallback mode.

5 Configuration 
area

Enables the configuration of parameters for the various channels. This field includes 
various items, displayed according to the selected discrete module.
The Symbol column displays the symbol associated with the channel.

Step Action
1 Open the desired module configuration screen.
2 Check the Supply monitoring  check box in the General Parameters area.

Result : The I/O editor window appears. Click OK.
3 Validate the change by clicking Edit → Validate.
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Fallback Mode Parameter
The fallback modes are as follows:

The following table shows the procedure for defining the fallback mode to be assigned to a channel group.

Output Reset Parameter
The reactivate mode is as follows:

The following table shows the procedure for defining the module output channel reset mode.

NOTE: The MC80 IO function does not support the capability to unconfigure channels as the NONE 
function.

Mode Meaning
Fallback Channels are set to 0 or 1 according to the defined fallback value for the corresponding 8-channel group.
Maintain The outputs remain in the status they were in before switching to Stop.

Step Action
1 Open the desired module configuration screen.
2 For the desired channel group, click the arrow of the Fallback mode drop-down menu.

Result : The following list appears

3 Select the desired fallback mode.
4 For Fallback mode, configure each channel of the selected group.

To do this, click the drop-down menu arrow of the channel to be configured, located in the  Fall Back Value 
column.

5 Click the desired value (0 or 1).
6 Confirm the modification with the Edit → Validate menu command.

Mode Meaning
Programmed Reactivation is executed with a command from the PLC application or through the appropriate debug 

screen.
Remark : In order to avoid repeated reactivations, the module implements an automatic 10 s delay 
between two resets.

Automatic The reactivation is executed automatically every 10 s until the error disappears.

Step Action
1 Open the desired module configuration screen.
2 For the desired channel group, click the arrow of the Reactivate drop-down menu.

Result : The following list appears.

3 Select the required reactivate mode.
4 Validate the modification by clicking Edit → Confirm.
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Digital I/O Device DDT
Discrete I/O supplies Device DDT (MDI_DIS_DDDT) for application usage.
The following table shows the Device DDT T_MC80_DIS_STD_IN_8_OUT_8

The following table shows the Device DDT T_MC80_DIS_STD_IN_8_OUT_12

The following table shows the T_MC80_DIS_STD_CH_IN structure meaning:

The following table shows the T_MC80_DIS_STD_CH_OUT structure meaning:

Analog Input Function 4 Channels Inputs
The various available screens for the analog functions are:
 Configuration screen
 Device DDT screen

Standard Symbol Type bit # Meaning Access
MOD_HEALTH BOOL - 0 = the module has a detected error

1 = the module is operating correctly
Read

MOD_FLT BYTE - Internal detected errors bytes of the 
module

Read

DIS_CH_IN[0...7] T_MC80_DIS_STD_CH_IN - Array [0...7] of 
T_MC80_DIS_STD_CH_IN

-

DIS_CH_OUT[16...23] T_MC80_DIS_STD_CH_OUT - Array [16...23] of 
T_MC80_DIS_STD_CH_OUT

-

Standard Symbol Type bit # Meaning Access
MOD_HEALTH BOOL - 0 = the module has a detected error

1 = the module is operating correctly
Read

MOD_FLT BYTE - Internal detected errors bytes of the 
module

Read

DIS_CH_IN[0...7] T_MC80_DIS_STD_CH_IN - Array [0...7] of 
T_MC80_DIS_STD_CH_IN

-

DIS_CH_OUT[16...27] T_MC80_DIS_STD_CH_OUT - Array [16...27] of 
T_MC80_DIS_STD_CH_OUT

-

Standard Symbol Type bit # Meaning Access
CH_HEALTH BOOL - 0 = the channel is inactive, including 

input power supply lose, input power 
supply under voltage, or over 
temperature
1 = the channel is active

Read

VALUE EBOOL indicates the status of the sensor 
controlling the input channel

Read

Standard Symbol Type bit # Meaning Access
CH_HEALTH BOOL - 0 = the channel is inactive.

1 = the channel is active
Read

VALUE EBOOL - indicates the status of the sensor controlling 
the output channel

Read 
/Write

CH_FLT [INT] EXT_PS_FLT BOOL 3 Internal detected error: module out of order Read
SHORT_CIRCUIT BOOL 8 External detected error: short-circuit on a 

channel
Read

REACTIVATION BOOL - Reactivation Read 
/Write
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The below screen shows MC80 Analog Input functions configuration screen:

This following table shows the various elements of the configuration screen and their functions:

For each input, the information related to the following are configurable in the configuration screen 
associated to the analog input:
 Range
 Scale factor
 Overflow (high and low limits)
 Filtering

Address Element Function
1 Tabs The tab in the foreground indicates the mode in progress (Configuration in this example). 

Every mode can be selected using the respective tab:
 Overview
 Configuation
 Device DDT which gives the Device DDT name and type of the device

2 Module area Specifies the abbreviated heading of the module.
3 Channel area Allows you:

 to click the reference number, to display the tabs:
 Description which gives the characteristics of the device

 to select a channel
 to display the Symbol, name of the channel defined by the user (using the variable 

editor)

NOTE: All channel are activated and a channel cannot be de-activated to None.

4 General 
parameters area

This is used to set up the channels using several fields:
Task: Defines the MAST task through which the exchanges between the processor and 
the module will be carried out.
Cycle: Allows you to define the scan cycle for inputs (only available on some analog 
modules).

5 Configuration 
area

This is used to define the configuration parameters of the different channels. This area 
includes several topics, whose display varies depending on the analog module you've 
selected.
The Symbol column displays the symbol associated with the channel.
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Selecting the Range for an Analog Input
This parameter defines the range for the input channel. Depending on the type of function, the input range 
may be:
 Voltage
 Current
The following table describes the procedure to define the type of task assigned to an analog function’s 
channels:

Task Parameter
This parameter defines the processor task MAST where input acquisitions and output updates are 
performed.

Selecting the Display Format for a Current or Voltage Input Channel
This parameter defines the display format for the measurement of an analog module channel whose range 
is configured for voltage or current.
The display format may be:
 standardized (%..):
 unipolar range: 0…+10,000
 bipolar range : -10,000…+10,000

 user-defined (User).
The following table provides the instructions defining the display scale assigned to an analog module 
channel:

Step Action
1 Access the hardware configuration screen for the appropriate module
2 In the Range column, click the arrow of the drop-down menu pertaining to the channel you need to configure.

Result : The following list appears

3 Select the appropriate range.
4 Validate the change by clicking Edit → Validate.

Step Action
1 Access the hardware configuration screen for the appropriate module.
2 Click the cell of the Scale column for the channel you need to configure.

Result: An arrow appears.
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Selecting the Input Channels Filter Value
This parameter defines the type of filtering for the input channel selected for analog function.
The available filtering values are:
 0: No filtering
 1 and 2: Low filtering
 3 and 4: Medium filtering
 5 and 6: High filtering
NOTE: Filtering is taken into account in both fast scan and normal cycles.
The following table provides instructions for defining the filter value assigned to input channels for analog 
function.

Analog Inputs Device DDT
Analog input supplies Device DDT (T_MC80_ANA_STD_IN_4) for application usage.

3 Click the arrow in the cell of the Scale column for the channel you need to configure.
Result: The Channel Parameters dialog box appears.

NOTE: The display modification change only concerns the Scale area. The Overflow area enables the 
modification of the overflow control.

4 Type in the values to be assigned to the channel in the two Display boxes situated in the Scale zone.
5 Confirm your changes by closing the dialog box.

NOTE: If default values have been selected (standardized display), the corresponding cell in the Scale 
column displays %... Otherwise it will show User (user display).

6 Validate the change by clicking Edit → Validate.

Step Action

Step Action
1 Access the hardware configuration screen for the appropriate module.
2 In the Filter column, click the arrow of the drop-down menu pertaining to the channel you need to configure.

Result : The drop-down menu appears.

3 Select the filter value you need to assign to the selected channel.
4 Validate the change by clicking Edit → Validate.
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The following table shows the T_MC80_ANA_STD_IN_4:

The following table shows the T_MC80_ANA_STD_CH_IN structure meaning:

The following table shows the T_MC80_ANA_VALUE_IN structure meaning:

Standard Symbol Type Bit # Meaning Access
MOD_HEALTH BOOL - 0 = the module has a detected error Read

- 1 = the module is operating correctly
MOD_FLT BYTE - Internal detected errors bytes of the module Read
ANA_CH_IN[0...3] T_MC80_ANA_STD_CH_IN - Array of structure -

Standard Symbol Type Bit # Meaning Access
FCT_TYPE WORD - 0 = channel is not used

1 = channel is used
Read

CH_HEALTH BOOL - 0 = the channel is inactive
1 = the channel is active

Read

CH_WARNING BOOL - 0 = no detected warning on the channel
1 = detected warning on the channel

Read

ANA T_MC80_ANA_VALUE_IN - Analog input structure -
MEASURE_STS 
[INT]

CH_ALIGNED BOOL 0 Aligned channel Read
LOWER_LIMIT BOOL 5 Measurement within lower tolerance zone Read
UPPER_LIMIT BOOL 6 Measurement within upper tolerance zone Read
INT_OFFSET_ERROR BOOL 8 Internal offset error Read
IN_REF_ERROR BOOL 10 Internal reference error Read
POWER_COM_ERROR BOOL 11 Power supply error Read
SPI_COM_ERROR BOOL 12 SPI communication error Read

CH_FLT [INT] SENSOR_FLT BOOL 0 External fault: sensor link fault Read
RANGE_UNF BOOL 1 External fault: Range under fault Read
RANGE_OVF BOOL 2 External fault: Range overrun fault Read
EXTERNAL_FLT BOOL 3 External fault: channel error report Read
INTERNAL_FLT BOOL 4 Internal fault: channel inoperative Read
CONF_FLT BOOL 5 Hardware or software configuration fault Read
COM_FLT BOOL 6 Bus communication fault Read
APPLI_FLT BOOL 7 Application fault Read
NOT_READY BOOL 8 Channel not ready Read
CALIB_FLT BOOL 9 Calibration fault Read

ALIGNMENT_CURRENT_VALUE INT - Current value of alignment Read
FILTER_CURRENT_VALUE INT - Current value of filter Read
ALIGNMENT_PRESET_VALUE INT - Preset value of alignment Write
FILTER_PRESET_VALUE INT - Present value of filter (0...6) Write
CMD_ALIGNMENT BOOL - Rising edge: execute command to change 

alignment with the preset alignment value
Write

CMD_FILTER BOOL - Rising edge: execute command to change filter 
with the preset filter value

Write

Standard Symbol Type Bit # Meaning Access
VALUE INT - Analog input value Read
FORCED_VALUE INT - Forced value Read/Write
FORCE_CMD BOOL - Force command Read/Write
FORCED_STATE BOOL - Forced state Read
TRUE_VALUE INT - Physical value Read
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High Speed Generic Counter
The following figure shows the counting modules configuration screen.

The following table describes the parts of the various screens:

Address Element Function
1 Tabs The tab in the foreground indicates the mode in progress (Configuration in this 

example). Every mode can be selected using the respective tab:
 Configuation

2 Module area Displays the name and status of a function.
Is used:
 To click the reference number, to display the tabs:
 Device DDT

3 Channel area Allows you:
 to click the reference number, to display the tabs:
 Description which gives the characteristics of the device

 to select a channel
 to display the Symbol, name of the channel defined by the user (using the variable 

editor)

NOTE: All channels are activated and a channel cannot be de-activated to None.

4 General 
parameters area

Allows you to select the counting function and the task associated with the channel:
Function: Counting function among those available for the modules involved. 
Depending on this choice, the headings of the configuration area may differ. By 
default, in Frequency Mode no function is configured.
Task: defines the MAST task through which the channel's implicit exchange objects 
will be exchanged. These choices are only possible in offline mode.

NOTE: In Configuration view, the events are not managed.

5 Parameters in 
progress area

This area has various functionalities which depend upon the current mode:
Configuration: It is used to configure the channel parameters.

NOTE: The Input and Output fault parameters are set by default with the value Local 
or General IO Fault.
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Frequency Mode Configuration
The following table describes the frequency mode configurable elements:

Label Configurable Values
IN_A input filter The least significant byte can take the following values:

0: Without,
1: low,
2: medium,
3: high.

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode
1:Local output fault mode

Scale factor Edit (value in the range 1...255)
Output block 0 This parameter can take the following values:

0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT),
7: Pulse = greater than the upper threshold (UT).

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Polarity 0 0:Polarity + 

1:Polarity - 
Polarity 1 0:Polarity + 

1:Polarity -
Fault recovery Automatic reaction

Activated
Fallback 0 0:Without

1:With 
Fallback 1 0:Without

1:With 
Fallback value 0 0

1
Fallback value 1 0

1
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Event Counting Mode Configuration
The following table describes the event counting mode configurable elements:

Label Configurable Values
IN_A input filter The least significant byte can take the following values: 

0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_SYNC input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode 
1:Local output fault mode

Synchronization edge 0:Rising edge at IN_SYNC
1:Falling edge at IN_SYNC 

Time base This parameter can take the following values: 
0: 0.1 s, 
1: 1 s,
2: 10 s, 
3: 1 min. 

Output block 0 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT), 
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Polarity 0 0:Polarity + 

1:Polarity - 
Polarity 1 0:Polarity + 

1:Polarity - 
Fault recovery Automatic reaction 

Activated 
Fallback 0 0:Without

1:With 
Fallback 1 0:Without

1:With 
Fallback value 0 0

1
Fallback value 1 0

1
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Period Measuring Mode Configuration
The following table describes the period measuring mode configurable elements:

Label Configurable Values
IN_A input filter The least significant byte can take the following values: 

0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_SYNC input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode 
1:Local output fault mode

Resolution This parameter can take the following values :
0: 1 µs,
1: 100 µs, 
2: 1 ms. 

Mode This parameter can take the following values :
0: From one edge to the same edge at input IN_A, 
1: From one edge to the opposite edge at input IN_A. 

Time out 1... 1073741823 
Output block 0 This parameter can take the following values: 

0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT), 
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Polarity 0 0:Polarity + 

1:Polarity - 
Polarity 1 0:Polarity + 

1:Polarity - 
Fault recovery Automatic reaction 

Activated 
Fallback 0 0:Without

1:With 
Fallback 1 0:Without

1:With 
Fallback value 0 0

1
Fallback value 1 0

1
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Ratio Mode Configuration
The following table describes the ratio mode configurable elements:

Label Configurable Values
IN_A input filter The least significant byte can take the following values: 

0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_B input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode 
1:Local output fault mode

Absolute limit Edit 
Output block 0 This parameter can take the following values: 

0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT), 
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Polarity 0 0:Polarity + 

1:Polarity - 
Polarity 1 0:Polarity + 

1:Polarity - 
Fault recovery Automatic reaction 

Activated 
Fallback 0 0:Without

1:With 
Fallback 1 0:Without

1:With 
Fallback value 0 0

1
Fallback value 1 0

1
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One Shot Counter Mode Configuration
The following table describes the one shot counter mode configurable elements:

Label Configurable Values
IN_A input filter The least significant byte can take the following values: 

0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_SYNC input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_EN input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode 
1:Local output fault mode

Scale factor Edit (value in the range 1...255)
Synchronization edge 0:Rising edge at IN_SYNC

1:Falling edge at IN_SYNC 
Output block 0 This parameter can take the following values: 

0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT), 
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).
8: Counter Stop
9: Counter Run

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).
8: Counter Stop
9: Counter Run

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Polarity 0 0:Polarity + 

1:Polarity - 
Polarity 1 0:Polarity + 

1:Polarity - 
Fault recovery Automatic reaction 

Activated 
Fallback 0 0:Without

1:With 
Fallback 1 0:Without

1:With 
Fallback value 0 0

1
Fallback value 1 0

1
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Modulo Loop Counter Mode Configuration
The following table describes the modulo loop counter mode configurable elements:

Label Configurable Values
IN_A input filter The least significant byte can take the following values: 

0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_B input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_SYNC input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_EN input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode 
1:Local output fault mode

Interface mode 0: A = High, B = Low,
1: A = Pulse, B = Direction, 
2: normal quadrature 1, 
3: normal quadrature 2, 
4: normal quadrature 4, 
5: inverse quadrature 1, 
6: inverse quadrature 2, 
7: inverse quadrature 4. 

Scale factor Edit (value in the range 1...255) 
Synchronization edge 0:Rising edge at IN_SYNC

1:Falling edge at IN_SYNC 
Output block 0 This parameter can take the following values: 

0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT), 
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).
10: Capture0 Low Out is High level if Capture value < LT
11: Capture0 In window Out is High level if LT ≤ capture value ≤ UT
12: Capture0 High Out is High level if LT ≤ capture value ≤ UT

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).
10: Capture0 Low Out is High level if Capture value < LT
11: Capture0 In window Out is High level if LT ≤ capture value ≤ UT
12: Capture0 High Out is High level if LT ≤ capture value ≤ UT

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
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Free Large Counter Mode Configuration
The following table describes the free large counter mode configurable elements:

Polarity 0 0:Polarity + 
1:Polarity - 

Polarity 1 0:Polarity + 
1:Polarity - 

Fault recovery Automatic reaction 
Activated 

Fallback 0 0:Without
1:With 

Fallback 1 0:Without
1:With 

Fallback value 0 0
1

Fallback value 1 0
1

Label Configurable Values

Label Configurable Values
IN_A input filter The least significant byte can take the following values: 

0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_B input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_SYNC input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_EN input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_REF input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

IN_CAP input filter The least significant byte can take the following values:
0: Without, 
1: Low, 
2: Medium, 
3: High. 

Input power supply fault 0:General input fault mode 
1:Local input fault mode

Output power supply fault 0:General output fault mode 
1:Local output fault mode

Interface mode 0: A = High, B = Low,
1: A = Pulse, B = Direction, 
2: normal quadrature 1, 
3: normal quadrature 2, 
4: normal quadrature 4, 
5: inverse quadrature 1, 
6: inverse quadrature 2, 
7: inverse quadrature 4. 

Scale factor Edit (value in the range 1...255) 
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Preset mode The least significant byte can take the following values: 
0: rising edge at IN_SYNC 
1: rising edge at IN_REF 
2: rising edge at IN_SYNC and IN_REF 
3: first rising edge at IN_SYNC and IN_REF at 1 
4: first rising edge at IN_SYNC and IN_REF at 0 

Present edge 0:Rising edge at IN_SYNC 
1:Falling edge at IN_SYNC 

Counter behavior 0:Lock on limits
1:Rollover

Capture 0 settings 0:Preset condition 
1:Falling edge at the IN_CAP input 

Output block 0 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT),
5: Pulse = greater than the lower threshold (LT), 
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).
10: Capture0 Low Out is High level if Capture value < LT
11: Capture0 In window Out is High level if LT ≤ capture value ≤ UT
12: Capture0 High Out is High level if LT ≤ capture value ≤ UT
13: Capture1 Low Out is High level if Capture value < LT
14 :Capture1 In window Out is High level if LT ≤ capture value ≤ UT
15 :Capture1 High Out is High level if LT ≤ capture value ≤ UT

Output block 1 This parameter can take the following values: 
0: Off, 
1: Low counter, 
2: Counter in a window, 
3: High counter, 
4: Pulse = less than the lower threshold (LT), 
5: Pulse = greater than the lower threshold (LT),
6: Pulse = less than the upper threshold (UT), 
7: Pulse = greater than the upper threshold (UT).
10: Capture0 Low Out is High level if Capture value < LT
11: Capture0 In window Out is High level if LT ≤ capture value ≤ UT
12: Capture0 High Out is High level if LT ≤ capture value ≤ UT
13: Capture1 Low Out is High level if Capture value < LT
14 :Capture1 In window Out is High level if LT ≤ capture value ≤ UT
15 :Capture1 High Out is High level if LT ≤ capture value ≤ UT

Pulse width 0 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Pulse width 1 Are a number of 2 ms in a range 1…32,767 (Even value from 2 ms to 65,534 ms)
Polarity 0 0:Polarity + 

1:Polarity - 
Polarity 1 0:Polarity + 

1:Polarity - 
Fault recovery Automatic reaction 

Activated 
Fallback 0 0:Without

1:With 
Fallback 1 0:Without

1:With 
Fallback value 0 0

1
Fallback value 1 0

1

Label Configurable Values
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HSC Device DDT
HSC supplies Device DDT for application usage.
The following table shows the T_MC80_CPT_STD_IN_2:

The following table shows the T_MC80_CPT_STD_CH_IN structure meaning:

Standard Symbol Type Meaning Access
MOD_HEALTH BOOL 0 = the module has a detected error Read

1 = the module is operating correctly
MOD_FLT BYTE Internal detected errors bytes of the module Read
CPT_CH_IN[0…1] T_MC80_CPT_STD_CH_IN Array of structure -

Standard Symbol Type Bit # Meaning Access
FCT_TYPE WORD - - -
CH_HEALTH BOOL - 0 = channel is inactive Read

1 = channel is active
ST_OUTPUT_0_ECHO EBOOL - logical state of output 0 Read
ST_OUTPUT_1_ECHO EBOOL - logical state of output 1 Read
ST_OUTPUT_BLOCK_0 EBOOL - status of physical counting output block 0 Read
ST_OUTPUT_BLOCK_1 EBOOL - status of physical counting output block 1 Read
ST_INPUT_A EBOOL - status of physical counting input A Read
ST_INPUT_B EBOOL - status of physical counting input B Read
ST_INPUT_SYNC EBOOL - physical state of the IN_SYNC input (or IN_AUX) Read
ST_INPUT_EN EBOOL - physical state of IN_EN input (enable) Read
ST_INPUT_REF EBOOL - physical state of the IN_REF input (preset) Read
ST_INPUT_CAPT EBOOL - physical state of IN_CAP input (capture) Read
COUNTER_STATUS [INT] RUN BOOL 0 the counter operates in counting mode only Read

MODULO_FLAG BOOL 1 flag set to 1 by a modulo switch event Read
SYNC_REF_FLAG BOOL 2 flag set to 1 by a preset or synchronization event Read
VALIDITY BOOL 3 the current numerical value is valid Read
HIGH_LIMIT BOOL 4 the current numerical value is locked at the upper 

threshold value
Read

LOW_LIMIT BOOL 5 the current numerical value is locked at the lower 
threshold value

Read

COMPARE_STATUS 
[INT]

COUNTER_LOW BOOL 0 current counter value less than lower threshold 
(LOWER_TH_VALUE)

Read

COUNTER_WIN BOOL 1 current counter value is between lower threshold 
(LOWER_TH_VALUE) and upper threshold 
(UPPER_TH_VALUE)

Read

COUNTER_HIGH BOOL 2 current counter value greater than upper threshold 
(UPPER_TH_VALUE)

Read

CAPT_0_LOW BOOL 3 Value captured in register 0 is less than lower 
threshold (LOWER_TH_VALUE)

Read

CAPT_0_WIN BOOL 4 Value captured in register 0 is between lower 
threshold (LOWER_TH_VALUE) and upper 
threshold (UPPER_TH_VALUE)

Read

CAPT_0_HIGH BOOL 5 Value captured in register 0 is greater than upper 
threshold (UPPER_TH_VALUE)

Read

CAPT_1_LOW BOOL 6 Value captured in register 1 is less than lower 
threshold (LOWER_TH_VALUE)

Read

CAPT_1_WIN BOOL 7 Value captured in register 1 is between lower 
threshold (LOWER_TH_VALUE) and upper 
threshold (UPPER_TH_VALUE)

Read

CAPT_1_HIGH BOOL 8 Value captured in register 1 is greater than upper 
threshold (UPPER_TH_VALUE)

Read

COUNTER_CURRENT_VALUE_S DINT - Current counter value during event Read
COUNTER_CURRENT_VALUE_US UDINT - Current counter value during event Read
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CAPT_0_VALUE_S DINT - Value captured in register 0 Read
CAPT_1_VALUE_S DINT - Value captured in register 1 Read
OUTPUT_0 EBOOL - forces OUTPUT_0 to level 1 Read / 

Write
OUTPUT_1 EBOOL - forces OUTPUT_1 to level 1 Read / 

Write
OUTPUT_BLOCK_0_ENABLE EBOOL - implementation of output 0 function block Read / 

Write
OUTPUT_BLOCK_1_ENABLE EBOOL - implementation of output 1 function block Read / 

Write
FORCE_SYNC EBOOL - counting function synchronization and start, which 

is valid only on rising edge
Read / 
Write

FORCE_REF EBOOL - set to preset counter value, which is valid only on 
rising edge

Read / 
Write

FORCE_ENABLE EBOOL - implementation of counter, which is valid only on 
rising edge

Read / 
Write

FORCE_RESET EBOOL - reset counter, which is valid only on rising edge Read / 
Write

SYNC_RESET EBOOL - reset SYNC_REF_FLAG Read / 
Write

MODULO_RESET EBOOL - reset MODULO_FLAG Read / 
Write

FUNCTIONS_ENABLING 
[INT]

VALID_SYNC BOOL 0 synchronization and start authorization for the 
counting function via the IN_SYNC input

Read / 
Write

VALID_REF BOOL 1 operation authorization for the internal preset 
function

Read / 
Write

VALID_ENABLE BOOL 2 authorization of the counter enable via the IN_EN 
input

Read / 
Write

VALID_CAPT_0 BOOL 3 capture authorization in the capture 0 register Read / 
Write

VALID_CAPT_1 BOOL 4 capture authorization in the capture 1 register Read / 
Write

COMPARE_ENABLE BOOL 5 comparators operation authorization Read / 
Write

COMPARE_SUSPEND BOOL 6 comparator frozen at its last value Read / 
Write

CH_FLT(Diagnostic) EXTERNAL_FLT_INPUTS BOOL 0 external detected error at inputs Read
EXTERNAL_FLT_OUTPUTS BOOL 1 external detected error at outputs Read
INTERNAL_FLT BOOL 2 internal detected error: channel inoperative Read
CONF_FLT BOOL 3 hardware or software configuration detected error Read
SENSOR_SUPPLY BOOL 4 low input power supply for the sensors Read
ACTUATOR_SUPPLY BOOL 5 output power supply loss Read
SHORT_CIRCUIT_OUT_0 BOOL 6 short circuit on output 0 -
SHORT_CIRCUIT_OUT_1 BOOL 7 short circuit on output 1 Read

Standard Symbol Type Bit # Meaning Access
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Configuring the Serial Port of the CPU

General Properties
The serial links of the CPU support two communication protocols:
 Modbus Serial
 Character Mode
Modbus is a standard protocol with the following properties:
 Establishes client/server communication between different modules within a bus or serial link. The client 

is identified by the master and the slave modules represent the servers.
 Composes of requests and responses data exchange modes and offers services via function codes.
 Establishes a means of exchanging frames from Modbus applications in two types of code; RTU mode 

and ASCII mode.
Character mode is a point-to-point mode of data exchange between two entities. It does not establish 
hierarchically structured serial link communications or offer services via function codes, unlike Modbus 
protocol. Character Mode is asynchronous.
Each item of textual information is sent or received character by character at irregular time intervals. The 
time taken by the exchanges can be determined from the following properties:
 One or two end-of-frame characters
 Timeout
 Number of characters

Configuration
Communicating via Serial link enables data exchange between all devices connected to the bus. The 
Modbus Serial is a protocol that creates a hierarchical structure (one master and several slaves).
The master manages all exchanges in two ways:
 The master exchanges with the slave and awaits a response.
 The master exchanges with all the slaves without waiting for a response (general broadcast).
NOTE: Be careful that two masters (on the same bus) do not send requests simultaneously otherwise the 
requests are lost and each report will have a bad result which could be 16#0100 (request could not be 
processed) or 16#ODFF (slave is not present).
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The below table describes the procedure for accessing the serial link:

Step Action
1 In the Project Browser, open the following directory: Station\Configuration\0: Bus MC80\0: processor 

reference\SerialPort.
The following screen appears:

2 Double-click the SerialPort sub-directory. The configuration screen appears.
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The following is the configuration screen:

The following table describes the different elements of the configuration screen:

Address Element Function
1 Tabs The tab in foreground indicates the current mode. The mode can be selected using 

the corresponding tab. The available modes are:
 Configuration

2 Channel zone Enables you to:
 Select between the serial port and channel 0 by clicking one or the other.
 Display the following tabs by clicking the SerialPort:
 Description, which gives the characteristics of the device.

 Display the following tabs by clicking the Channel 0:
 Configuration

 Display the channel name and symbol defined by the user using the variables 
editor.

3 General parameters 
zone

This enables you to choose the general parameters associated with the channel:
 Function:The available functions are Modbus and Character Mode. The default 

configuration is with the Modbus function.
 Task: Defines the master task in which the implicit exchange objects of the 

channel will be exchanged. This zone is grayed out and therefore not 
configurable.

4 Configuration zone In configuration mode, this zone is used to configure the channel parameters.
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Modbus Serial communication

Modbus Serial Communication Configuration Screen
To access the Modbus serial communication configuration screen, open the Serial Port directory in the 
project browser  (see page 111).
The figure below shows the default configuration screen for Modbus serial communication:

These zones are used to configure channel parameters. In offline mode, these zones are accessible. In 
online mode, the zone is accessible but some parameters are unavailable.
The following table shows the different zones of the Modbus link configuration screen:

NOTE: When configuring Modbus Serial communication in Master mode, the Slave zone is unavailable for 
modification and vice-versa.

Key Element Description
1 Application parameters These parameters are accessible via 3 zones:

 Type
 Master
 Slave

2 Transmission parameters These parameters are accessible via 5 zones:
 Transmission speed
 Delay between frames
 Data
 Stop bits
 Parity

3 Signal and physical line parameters These parameters are accessible via 3 zones:
 Physical line
 Signals
 RTS/CTS delay
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Accessible Modbus Functions
The table below shows the different functions configurable according to the type of serial link used: 

NOTE: All Modbus Serial communication parameters have default values.
The table below shows the default values for Modbus Serial communication parameters:

Function RS485 Link RS232 Link
Master number of retries X X
Master response time X X
Slave number X X
Transmission speed X X
Delay between frames X X
Data  ASCII (7 bits)

 RTU (8 bits)
 ASCII (7 bits)
 RTU (8 bits)

Stop  1 bit
 2 bits

 1 bit
 2 bits

Parity  Odd
 Even
 None

 Odd
 Even
 None

RX/TX signals - X
RTS / CTS delay - X
RX/TX/CTS(DCE Mode) - X
X: Accessible function
-: Inaccessible function

Configuration Parameter Value
Mode Master
Physical Line RS485
Slave number -
Delay between frames 2 ms
Transmission speed 19,200 bits/s
Parity Even
Data Bits RTU (8 bits)
Stop bits 1 bit
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Application-linked Modbus Parameters
After configuring the communication channel, enter the application parameters.
These parameters are accessible from three configuration zones:
 The Type zone
 The Master zone
 The Slave zone
The following table describes the zones:

Zone Screen Description
The Type zone This zone enables you to select the type of Modbus 

Serial to be used:
 Master: When the station concerned is the 

master.
 Slave: When the station concerned is a slave.

The Master zone This zone enables you to enter the following 
parameters:
 Number of retries: Number of connection 

attempts made by the master before defining 
the slave as absent. The default value is 3. 
Possible values range from 0…15. A value of 0 
indicates no retries by the Master.

 Answer delay: The time between the Master’s 
initial request and a repeated attempt if the slave 
does not respond. This is the maximum time 
between the transmission of the last character 
of the Master's request and receipt of the first 
character of the request sent back by the slave. 
The default value is 1 second (100*10 ms). 
Possible values range from 10 ms to 10 s.

NOTE: The Answer delay of the Master must be at 
least equal to the longest Answer delay of the 
Slaves present on the bus.

The Slave zone This zone enables you to enter the processor’s 
slave number. The default value is 1. Possible 
values range from 1…247.
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Transmission-linked Modbus Parameters
After configuring the communication channel, enter the transmission parameters.
These parameters are accessible from five zones:
 The Transmission Speed zone
 The Delay between frames zone
 The Data zone
 The Stop zone
 The Parity zone
The following table describes the zones:

Zone Screen Description
The Transmission 
Speed Zone

This zone allows you to select the transmission speed of the 
Modbus Serial. The selected speed has to be consistent with 
the other devices. The configurable values are 300, 600, 
1,200, 2,400, 4,800, 9,600 and 19,200 bits per second.

NOTE: The transmission speed of 38,400 bps is not 
supported (300…19,200 bits/s) for all functions.

The Delay 
between frames 
zone

The Delay between frames is the minimum time separating 
two frames on reception. This delay is managed when the PLC 
(master or slave) is receiving messages.

NOTE: The default value depends on the selected 
transmission speed.

NOTE: The delay between frames should be the Default 
value in order to be Modbus compliant. In case a Slave is not 
conform, the value can be changed and should be identical for 
the Master and all Slaves on the Bus.

The Data zone This zone allows you to enter the type of coding used to 
communicate using Modbus Serial. This field is set according 
to the other devices connected on the bus. There are two 
configurable modes:
RTU mode:
 The characters are coded over 8 bits.
 The end of the frame is detected when there is a silence of 

at least 3.5 characters.
 The integrity of the frame is checked using a word known 

as the CRC checksum, which is contained within the frame.
ASCII mode:
 The characters are coded over 7 bits.
 The beginning of the frame is detected when the ":" 

character is received.
 The end of the frame is detected by a carriage return and a 

line feed.
 The integrity of the frame is checked using a byte called the 

LRC checksum, which is contained within the frame.
The Stop zone This zone allows you to enter the number of stop bits used for 

communication. This field is set according to the other 
devices. The configurable values are:
 1 bit
 2 bits

The Parity zone This zone enables you to determine whether a parity bit is 
added or not, as well as its type. This field is set according to 
the other devices. The configurable values are:
 Even
 Odd
 None
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Signal and Physical Line Parameters in Modbus
After configuring the communication channel, enter the signal and physical line parameters.
These parameters are accessible via three zones:
 The Physical line zone
 The Signals zone
 The RTS/CTS delay zone
The following table describes the zones:

Modbus Serial Communication Programming 
When used as the master in a Modbus link, MC80 supports several services via the READ_VAR, 
WRITE_VAR and DATA_EXCH communication functions. 

When used as a slave in a Modbus link, it manages the following requests: 

Zone Screen Description
The Physical line 
zone

In this zone, you can select the line for the channel 0 of the CPU between:
 The RS232 line
 The RS485 line

The Signals zone In this zone, you can select the signals supported by the RS232 physical 
line:
 RX/TX
 RX/TX + RTS/CTS DCE mode

If the RS485 is configured, the entire zone will be unavailable and the 
default value is RX/TX.

NOTE: The Modbus Master is the default type. When RS232 is selected, 
DTE mode is not supported but DCE mode is supported.

The RTS/CTS 
delay zone

The RTS/CTS delay zone is available only when both RS232 and 
RX/TX+RTS/CTS check boxes are selected. An RTS/CTS flow control 
algorithm is selected if the default value is 0 ms. A value different from 0 
enables an RTS/CTS modem control algorithm.
The RTS/CTS flow control algorithm (DTE <-> DTE) is different from the 
RTS/CTS modem control algorithm (DTE <-> DCE) as follows:
 The RTS/CTS flow control algorithm is related to the overflow 

reception buffer (full duplex).
 The RTS/CTS modem control algorithm deals with the shared 

transmission process, e.g. a radio modem.

Modbus Request Function Code Communication Function
Read bits 16#01 or 16#02 READ_VAR
Read words 16#03 or 16#04 READ_VAR
Write bits 16#0F WRITE_VAR
Write words 16#10 WRITE_VAR
Other request all DATA_EXCH

Modbus Request Function Code PLC Object
Read n output bits 16#01 %M
Read n output words 16#03 %MW
Write n output bits 16#0F %M
Write n output words 16#10 %MW
118 EIO0000002071 06/2020



Configuration of MC80
Character Mode Communication

Character Mode Communication Configuration Screen
To access the Character mode communication configuration screen, open the SerialPort sub-directory in 
the project browser  (see page 111), and select the Character mode link function.
The following figure shows the default configuration screen for Character mode communication:

These zones are used to configure channel parameters. In the online mode, these zones are accessible. 
In the offline mode, these zones are accessible but some parameters may not be accessible and are 
grayed out.
The following table shows the different zones of the Character mode communication configuration screen:

Key Element Comment
1 Message end detection parameters This parameters are accessible via two zones:

 Stop on reception
 Stop on silence

2 Transmission parameters This parameters are accessible via four zones:
 Transmission speed
 Data
 Stop bits
 Parity

3 Signal and physical line parameters This parameters are accessible via three zones:
 Physical line
 Signals
 RTS/CTS delay
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Accessible Functions in Character Mode
The following table shows the different functions configurable according to the type of serial link used:

The following table shows the default values for Character mode communication parameters:

Message End Detection Parameters in Character Mode
After configuring the communication channel, enter the message end detection parameters.
These parameters are accessible via two zones:
 The Stop on reception zone: stop on reception of a special character.
 The Stop on silence zone: stop on silence.
Selecting Stop on silence means that Stop on reception is deselected and vice versa.

Function RS485 Link RS232 Link
Transmission speed X X
Data  7 bits

 8 bits
 7 bits
 8 bits

Stop  1 bit
 2 bits

 1 bit
 2 bits

Parity  Odd
 Even
 None

 Odd
 Even
 None

Stop on reception X X
Stop on silence X X
RX/TX Signals X X
RTS/CTS Signals - X
RTS/CTS delay - X
X: Accessible function
-: Inaccessible function

Configuration parameter Value
Physical Line RS232
Transmission speed 9,600 bits/s
Parity Odd
Data Bits 8 bits
Stop bits 1 bit
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The following table describes the zones:

Transmission Parameters in Character Mode
The transmission parameters in Character mode is same as Modbus Serial communication .

Zone Screen Description
The Stop on reception zone A reception request can be terminated once a 

specific character is received.
Select the Stop option to configure the Stop on 
reception feature which can be activated by a 
specific end-of-message character:
 CR: enables you to detect the end of the 

message by a carriage return.
 LF: enables you to detect the end of the 

message by a line feed.
 Data entry field: enables you to identify an 

end-of-message character other than the CR 
or LF characters, using a decimal value:
 Between 0 and 255 if the data is coded 

over 8 bits
 Between 0 and 127 if the data is coded 

over 7 bits
 Character included: enables you to include 

the end-of-message character in the 
reception table of the PLC application.

It is possible to configure two end-of-reception 
characters. For example, the end-of-reception of 
a message can be detected by an LF or CR 
character.

The Stop on silence zone This zone enables you to detect the end of a 
message on reception by the absence of 
message end characters over a given time. Stop 
on silence is validated by checking the Stop 
check box. The duration of the silence 
(expressed in milliseconds) is set using the data 
entry field.

NOTE: The available values range from 
1…10,000 ms depending on the transmission 
speed selected.
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Signal and Physical Line Parameters in Character Mode
After configuring the communication channel, enter the signal and physical line parameters.
These parameters are accessible via 3 zones:
 The Physical line zone
 The Signals zone
 The RTS/CTS delay zone
The following table describes the zones:

Character Mode Communication Programming
The three specific communication functions are defined for sending and receiving data via communication 
channel in Character mode:
 PRINT_CHAR: send a character string (maximum of 1,024 bytes).
 INPUT_CHAR: read a character string (maximum of 1,024 bytes).
 INPUT_BYTE (see Unity Pro, Communication, Block Library): read a byte array (maximum of 1,024 

bytes).
Since the Modicon MC80 PLC serial port is full duplex with RS232 link, a PRINT_CHAR function can be 
sent when an INPUT_CHAR function is sent and is in pending state.
NOTE: For INPUT_CHAR function, a configured time-out is necessary to acknowledge the activity bit of 
the function, if the channel is configured without Stop on silence. For PRINT_CHAR function, it is advisable 
but not necessary to configure a time-out.

Zone Screen Description
The Physical line 
zone

In this zone, you can select the line for the channel 0 of the CPU 
between:
 The RS232 line
 The RS485 line

The Signals zone In this zone, you can select the signals supported by the RS232 
physical line:
 RX/TX
 RX/TX + RTS/CTS Full Duplex (DTE mode)

If the RS485 is configured, the entire zone is grayed out and the 
default value is RX/TX.

The RTS/CTS 
delay zone

The RTS/CTS delay zone is available only when both RS232 and 
RX/TX+RTS/CTS check boxes are selected.
An RTS/CTS flow control algorithm is selected: 
before a character string is transmitted, the system waits for the 
CTS (Clear To Send) signal to be activated. This zone enables you 
to enter the maximum waiting time between the two signals. When 
this value is timed out, the request is not transmitted on the bus. 
The Configurable values range from 0...10 s.

NOTE: The default value is 0 ms.

NOTE:  A value of 0 s indicates that the delay between the two 
signals is not managed.
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Configuring the Ethernet Port of the CPU

Configuration
In the application browser, you can create an Ethernet network from the Communication node similar to 
the older versions of Control Expert (formerly Unity Pro).
To link the network to the Ethernet port of the CPU, use the Ethernet configuration screen.
Open the Ethernet configuration screen:
 Double-click the Ethernet connector node in the application browser.

Or
 Double-click the Ethernet hotspot of the CPU in the bus editor.

Creating a Network
Create a logical Ethernet network:

Step Action
1 In the Project Browser, right-click the Network subdirectory in the Communication directory and select the 

New Network option.
Result: The Add Network screen appears.

2 Choose Ethernet in the List of available networks and choose a meaningful name for your selection:

3 Click OK. A new logic network will be created.
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Accessing a Network Configuration
Access the logical Ethernet network configuration:

The configuration screen is divided into several zones:
 Model Family: Select the model family for configuration.
 Module Address: This zone is unavailable.
 Module IP Address: This field displays the module’s IP address.

Linking the Ethernet Network to the Embedded Ethernet
Configure the Ethernet link and link the Ethernet network created in the communication manager: 

Services available for the MC80 CPU
These Network Services are configured inside Control Expert for the MC80 CPU:
 Security
 IP Configuration
 Simple Network Management Protocol (SNMP) (Client)
 Standard MIB Only
 MIB Transparent Factory not supported

 Rapid Spanning Tree Protocol (RSTP)
 Bandwidth

Security
This Security Service applies to the Cyber Security of the MC80 network.
Access the Security tab from the index page:

Step Action
1 Open the project browser in order to see the logic networks of your application.
2 Right-click the Ethernet logic network to be configured and select Open.

Result: The Ethernet configuration screen is displayed.

3 Scroll to choose the Model Family of your network.

Step Action
1 Open the Ethernet configuration screen.
2 Configure the Ethernet link with the ETH TCP IP function.
3 Link to the Ethernet network.

Step Action
1 Access the module configuration screen.
2 Select the Security tab as shown in the following figure.
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This is the Security tab:

This table describes the features behavior with limited checks:

Access Control List (ACL)
The list of authorized addresses applies only to the devices that can communicate with the MC80 CPU via 
the port 502 server. The list also applies to the CPU firmware downloads.
When the access control is enabled, add the IP addresses of the authorized addresses. The devices can 
communicate only with authorized addresses.
To define the list of authorized addresses, you can enter one of the following:
 an IP address in the IP Address column and select NO in the Subnet column
 a subnet address in the IP Address column, select YES in the Subnet column and enter subnet mask 

in the Subnet Mask column.
NOTE: The subnet in the IP Address column can be the subnet itself or any IP address of the subnet. If 
you enter a subnet without a subnet mask, a detected error displays stating that the screen cannot be 
validated.
You can enter up to 128 authorized IP addresses.

File Transfer Protocol (FTP)
The Schneider Electric Ethernet devices use FTP for various tasks including firmware loading and 
retrieving error logs.
Schneider Electric recommends you to disable FTP when not required, as FTP is vulnerable to various 
cyber security attacks.

IP Configuration
Access the IP configuration tab from the index page:

Feature Characteristic
FTP Enabled or Disabled
Access Control Enabled or Disabled
ACL with 128 lines 1 hidden reserved for USB

NOTE: By default, the Security is Enforced (FTP Disabled and Access Control Enabled).

Step Action
1 Access the module configuration screen.
2 Select the IP configuration tab as shown in the following figure.
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This is the IP configuration tab:

These are the configuration parameters for IP addresses:

NOTE: TCP/IP communications use the Ethernet II frame format, which complies with the RFC 894 
standard.

Zone Description
IP address 
configuration 

On the IP Configuration tab, you can define the IP address of a module in the IP address 
configuration zone. The options are:
 Configured: Manually enter the IP address, subnetwork mask, and gateway address.
 From a server: The configuration is supplied by a server device.

NOTE: To configure IP addresses, obtain the appropriate network address and subnetwork mask 
from your system administrator.

Configured Selecting the Configured option allows manual configuration according to your own requirements:
 IP Address: The IP address of the module
 Subnetwork mask: The mask defines the part allocated to the subnetwork identifier in the IP 

address.
 Gateway Address: The gateway address is the IP address of the default gateway to which 

messages for other networks are transmitted.

NOTE: 
 If the module is connected to an existing TCP/IP network, the IP addresses are administered 

globally, therefore the IP parameters must be configured. Otherwise there may be an instance of 
duplice IP addresses on the existing network.

 The configured IP address is valid only when the lower rotary switch turns to "Stored" position.

From a server Selecting the From a server option allows the configuration of module’s IP address from a remote 
device acting as a DHCP server. When the From a server button is active:
 Leaving the Device Name field empty facilitates communications that are compatible with any 

setting on the rotary switches.
 To use a device name in the Device Name field, set the lower rotary switch to its STORED 

position. If you set the switch any other position, the result depends on the setting of the lower 
rotary switch, as described in the Ethernet Port Status table.

 The configured IP parameters have no effect and are grayed out.

NOTE: The maximum length for the device name is 16 characters. Valid characters include 
alphanumerics (0…9, A…Z) and underscores.
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Port Status
The status of the Ethernet port depends on the IP address configuration in the application and the setting 
on the rotary switches:

SNMP
Access the SNMP tab from the index page:

Application Switch Setting
DHCP (device name 
from rotary switches)

DHCP STORED CLEAR IP DISABLED

None DEFAULT: Get IP 
address. (1)

DEFAULT: Get IP 
address. (1)

DEFAULT: Use 
default IP address. (1)

DEFAULT: This 
switch setting 
implements device’s 
default IP parameters 
regardless of the 
application type.

LED off. This switch 
setting stops 
communications 
between the module 
and the network, so 
the application type is 
inconsequential.

Configured MISMATCH: Get IP 
address. (1)

MISMATCH: Get IP 
address. (1)

NO ERROR: Get IP 
address from 
application. (2)

Configured

From a server without 
device name (3)

NO ERROR: Get IP 
address. (2)

NO ERROR: Get IP 
address. (2)

NO ERROR: Get IP 
address with DHCP. 
(2)

From a server without 
device name (3)

From a server with 
device name

NO ERROR: Get IP 
address. Device 
name derived from 
switches (2) (5)

MISMATCH: Get IP 
address. (1)

NO ERROR: Get IP 
address with DHCP 
(device name from 
application). (2)(4)

From a server with 
device name

(1) Start default services only
(2) Start application-configured services
(3) Leaving the From a server/Device Name field empty on the IP Configuration tab facilitates communications that are compatible with any 
rotary switch setting.
(4) To use the device name from the IP Configuration tab in the Control Expert application, the lower rotary switch must be set to one of its 
STORED positions.
(5) When the server returns a name that matches the one you configure on the IP Configuration tab, communications are OK. When there is 
a mismatch, there is a communications error.
(6) The MC80 Ethernet modules will not receive an IP address from a DHCP server on application download if the IP configuration has not 
changed.

CAUTION
UNINTENDED EQUIPMENT OPERATION
The communications port can enter the idle state when the position of the rotary switches does not match 
the port network configuration in the application. For example, the switches may be set to DHCP while 
the application calls for a fixed IP address.
Failure to follow these instructions can result in injury or equipment damage.

Step Action
1 Access the module configuration screen.
2 Select the SNMP tab as shown in the following figure.
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This is the SNMP tab:

This procedure gives the configuration principles for SNMP:

These are the SNMP configuration parameters:

Step Action
1 Enter the IP address managers addresses:

 IP address manager 1
 IP address manager 2

2 Fill in the Agent fields:
 Location (SysLocation)
 Contact (SysLocation)

Or alternatively check the SNMP manager check box to indicate that the information will be completed by the SNMP manager.
3 If you want to set access rights, fill in the Community names:

 Set
 Get
 Trap

Zone Description

SNMP Parameters on the SNMP configuration tab are divided into four categories:
 the IP addresses of SNMP manager devices
 SNMP agents
 the community names
 security
NOTE: Only 7-bit ASCII characters can be used in the character string entry fields.

IP address 
managers

This zone allows you to complete the IP addresses of the SNMP managers. The modules authorize a maximum of two managers.
These addresses are used during possible transmission of events (TRAP). The transmission of supervised data is detailed at the topic 
SNMP.

Agent This zone allows the localization and identification of an agent from the SNMP manager.
It consists of two fields:
 The Location (SysLocation) field: Indicates the physical location of the device (32 characters maximum).
 The Contact (SysLocation) field: Indicates the person to contact for device management and the method of contact (strings of 32 

characters maximum).
 If you prefer to have this information assigned by an SNMP Manager tool for network management, check the SNMP Manager check 

box.

Community 
names

This zone is used to define community names for the Set, Get and Trap utilities. It consists of three fields:
 The Set field defines the community name for the Set utility (strings of 16 characters maximum). The default value of the field is 

Public.
 The Get field defines the community name for the Get utility (strings of 16 characters maximum). The default value of the field is 

Public.
 The Trap field defines the community name for the Trap utility (strings of 16 characters maximum). The default value of the field is 

Public.
The purpose of these fields are to define the access rights for the MIB objects of the SNMP agent (local module) in relation to requests 
sent by the manager.
Example: If the manager sends a SetRequest request with the community name Test and the module has the community name Public, 
the request is not executed.

Security This zone contains the Enable "Authentication Failure" trap check box. Checking this box allows you to validate the transmission of an 
authentication failure event (TRAP) from the SNMP agent to the configured manager. In this way, the agent warns the manager that 
the request has been refused following an identification error (community name configured in the manager is different from the one 
configured in the agent).
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RSTP
Access the RSTP tab from the index page:

This screen shows the RSTP screen for an MC80 Ethernet network, you can choose the priority of the 
bridge from the Bridge Priority arrow:

These are the RSTP configuration parameters:

CAUTION
UNEXPECTED NETWORK BEHAVIOR - SNMP PARAMETERS RESET
The SNMP manager is able to modify the value of certain configurable parameters (Enabling "Authenti-
cation failure," Location, Contact. etc.). The SNMP Manager box is not checked and there is a cold start, 
warm restart, or application download, the initially configured values are restored.
Failure to follow these instructions can result in injury or equipment damage.

Step Action
1 Access the module configuration screen.
2 Select the RSTP tab as shown in the following figure.

Zone Description
Bridge Priority Select one of the following values in the drop-down list:

 Root (0)
 Backup Root (4096) 
 Participant (32768) 

NOTE: Network switches running RSTP software periodically exchange information about 
themselves using special packets called Bridge Protocol Data Units (BPDUs), which act as a 
heartbeat. The Bridge Priority value is stored in the BPDU and it establishes the relative position 
of the switch in the RSTP hierarchy. 

Forward delay The delay used by STP Bridges to transition Root and Designated Ports to Forwarding.
Maximum Age This value is set to the length of time, from 6…40 seconds the switch waits for receipt of the next 

hello message, before initiating a change to the RSTP topology. Default = 40 s. 
Transmit Hold Count The maximum number of BPDUs, from 1…40, the switch can transmit per second. Default = 40.
Hello Time When the frequency is set at 2 seconds, the embedded switch sends heartbeat BPDUs.
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Bandwidth
Access the Bandwidth tab:

This is the Bandwidth tab for an MC80 Ethernet network:

Port Features
These are the features of the Ethernet port:

Step Action
1 Access the module configuration screen.
2 Select the Bandwidth tab as shown in the following figure.
3 Select the appropriate Ethernet Environment zone.

 Isolated: Lessens the impact of Ethernet communication on the scan by limiting the number of polled 
Ethernet messages to 500 per second

 Mastered: Increases the maximum number of polled messages to 1,000 per second
 Open: Increases the maximum number of polled messages to 2,200 per second

4 Enter the estimate for the Messaging information zone.
5 If the module overflows, the message "The maximum number of messages for the Extended Ethernet 

network must not exceed 2,000 messages" appears.

Feature Description
addressing STORED

CLEAR IP
DHCP

supported application protocols Stored IP (from application)
IP from BootP
IP from DHCP
MAC-based IP
Modbus messaging
FDR client
FDR server
SNMP agent
Bandwidth Management
FTP
ARP
RSTP

auto MDI/MDI-X supported
auto-negotiation supported
connector type dual-shield RJ45
max. connections for Modbus TCP 
(port 502) all services included

16 Modbus TCP connections as server
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max. connections for Modbus TCP 
(port 502) messaging only

Modbus TCP connections as server not taking into account IO scanner, from 
which only one connection is used by Control Expert in programming mode.
Modbus TCP connections as client not taking into account IO Scanner, i.e. 6 
simultaneous communication EFB on Ethernet.

max. connections for FTP 1 (for firmware upgrade only)
max. server requests per cycle 8
max. client requests per cycle 4
max. message length 1026 including network headers
max. message throughput for 
Modbus TCP

This value is a function of the PLC cycle (PLC cyc * max req/cyc).
The default value in not configured in an M340 system.

max. message throughput for 
Modbus TCP

The Ethernet Environment (or CPU load) identified in the Bandwidth window:
 isolated
 mastered
 open

Feature Description
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CANopen Configuration

Bus Configuration
Follow the below steps to access the CANopen field bus:

Follow the steps below to add a device connected to the CANopen bus:

Step Action
1 From the project navigator, expand the Configuration directory.

Result: The following screen appears:

2 To open the CANopen bus screen, select one of the following methods:
 double-click the CANopen directory
 select the CANopen sub-directory and select Open in the contextual menu.

Result: The CANopen window appears.

Step Action
1 Access the CANopen configuration screen.
2 Double-click the place where the module should be connected.

Result: The New Device screen appears.
3 Enter the number of the connection point corresponding to the address.

By default, the Unity Pro software offers the first free consecutive address.
4 In the Communicator field, select the element type enabling communication on the CANopen bus.

For modules with built-in communicators, this window does not appear.
5 Validate with Ok.

Result: The module is declared.
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Follow the steps below to delete a device connected to the CANopen bus:

Follow the steps below to move a device connected to the CANopen bus:

Follow the steps below to duplicate a device connected to the CANopen bus:

Master Configuration
The Master configuration and the devices configuration are stored in the PLC application in order to be 
used by the CANopen stack of the MC80 firmware.
The following table describes how to Access the CANopen Master Configuration screen:

Step Action
1 Access the CANopen configuration screen.
2 Right-click the connection point of the device to be deleted, then click Delete the drop.

Step Action
1 Access the CANopen configuration screen.
2 Select the connection point to be moved (a frame surrounds the selected connection point).
3 Drag and drop the connection point to be moved to an empty connection point.

Result: The Move Device screen appears.
4 Enter the number of the destination connection point.
5 Confirm the new connection point by pressing OK.

Result: The Move Device screen appears.
6 Confirm the modification by selecting Yes to modify the addresses of the inputs/outputs objects in the 

program and move the variables associated with these objects.

Step Action
1 Access the CANopen configuration screen.
2 Right-click the device to be copied, then click Copy.
3 Right-click the connection point desired, then click Paste.

Result: The New Device screen appears.
4 Enter the number of the destination connection point.
5 Confirm the new connection point by selecting OK.

Step Action
1 Open the CANopen directory under BUS MC80 directory

Result: The following screen appears:

Double-click the processor's CANopen port.
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The following table describes the different areas which make up the master configuration screen:

2 The master configuration screen appears:

Address Element Function
1 Tab The tab in the foreground indicates the type of screen displayed. In this case, it is the 

configuration screen.
2 Module area This area is made up of the abbreviated heading of the processor equipped with a 

CANopen port.
3 Channel area This zone allows you to select the communication channel to be configured.

By clicking the device, you display the tabs:
Overview: Gives the characteristics of the built-in CANopen port,
By clicking a channel, you display the tabs:
Configuration: Enables you to declare and configure the CANopen master

4 General 
parameters area

This field enables you to:
 Associate the CANopen bus to an application task
 MAST which is the master task

The tasks are asynchronous in relation to exchanges on the bus.
5 Configuration area This field enables you to:

 Configure the parameters of the CANopen bus.

Step Action
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The following table describes the configuration parameters for CANopen Master Configuration screen:

Parameter Description
Outputs- 
Fallback

The fallback information area contains two options, which defines the behavior of the device when the 
CPU is in STOP or in HALT:
 Maintain: Maintains outputs (values are kept),
 Reset: Resets outputs (values are set to 0).

NOTE: The Bus Stop when PLC stop check box in the fallback area configuration is only available in 
CANopen expert mode.
 If it is not checked: the CANopen bus remains in RUN after a PLC stop and the global strategy of 

fallback is applied to the outputs according to Maintain or Reset radio button. 
 If it is checked: the CANopen bus is stopped when a PLC stop; in this case, Maintain and Reset 

radio buttons are greyed out. 
Bus 
Parameters

To configure the bus, it is necessary to indicate the following parameters:
 Transmission speed – 250 kBauds default
 SYNC Message COB-ID - 128 default
 SYNC Message Period - 100 ms default
 NMT inhibit time - 5 ms default. During Bootup, the CANopen Master implements a delay between 

each NMT messages to avoid slave overload. The value must be given in multiple of 100 µs. The 
value 0 disables the inhibit time.

 Device Bootup Time Out - 50 ms default. The global SDO timeout for the master is related to the 
scanning of the network. During this time, the master reads the object 1000 of each slave to analyze 
the CANopen bus configuration.

 Specific SDO timeout: 15,000 ms default. The slaves SDO timeout is necessary for devices with 
long response times i.e. for accesses to the objects 1010,1011,1F50. A grid displays all present 
devices with the NodeId, the name and the timeout value.

NOTE: Only 16 devices are supported in 16 possible addresses from 1…16.
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Device Configuration
To configure a slave, perform the following actions:

The following figure shows an example of the configuration screen of a slave:

Step Action
1 Access the CANopen bus configuration screen.
2 Double-click the slave to be configured.
3 Configure the Bootup Procedure using the Bootup tab.
4 Integrate a third pary product using the Object Dictionary tab.
5 Configure the usage function using the Configuration tab.
6 Configure the PDOs using the PDO tab.
7 Select the error control using the Error control tab.
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The following table shows the various elements of the configuration screen and their functions:

The animation of the CANopen bus editor is based on:
 %S118 for the general bus animation
 %SW172 (List of CANopen operational slaves) for animating the drops health
The following screen shows the CANopen Device PDO screen:

Address Element Function
1 Tab The tab in the foreground indicates the type of screen displayed. In this 

case, it is the configuration screen.
2 Module area Gives a reminder of the device’s shortened name.
3 Channel area This zone allows you to select the communication channel to be configured.

By clicking the device, you display the following tabs:
 Description: Gives the characteristics of the device
 CANopen: Allows you to access SDO (in online mode)
 Device DDT: Pre-symbolizing of the input/output objects

By clicking the channel, you display the following tabs:
 PDO (input/output objects)
 Error control
 Bootup
 Object DIctionary
 Configuration

4 General 
parameters area

This field allows you to select the slave function.

5 Configuration area This area is used to set up the channels of the devices.
Some devices can be configured with an external tool. In this case, the 
configuration is stored in the device and you cannot enter configuration 
parameters because this field is empty.
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The following table lists the behavior of configuring CANopen devices in Unity:

Hardware Catalog Manager
The Catalog Manager is a software tool that allows management of CANopen devices in the Unity Pro 
catalog database.
The Catalog Manager is a separate software that can be used to:
 Integrate third party products.
 Add, remove and configure access to CANopen devices on the fieldbus.
 Minimize the size of the CPU memory reserved for a given equipment.
 Customize the user interface.
The Unity user interface works on a catalog database which is installed with Unity Pro, and uses some 
basic services from the Unity Pro installation. Therefore Unity Pro software must be installed on your 
workstation, for the Catalog Manager to work.
NOTE: An overview of the Catalog Manager in read only mode is available in Unity Pro through the 
Hardware Catalog.
The Catalog Manager is composed of three levels of data:
 Device Families
 Devices
 Functions

Zone Description
PDO PDOs make it possible to manage the communication flow between the CANopen Master and the 

slaves. The PDO tab allows you to configure a PDO.
 Transmit PDOs: Information transmitted by the Slave to the Master,
 Receive PDOs: Information received by the Slave from the Master,
 Variables: Variables that can be mapped to the PDOs. To assign a variable to a PDO, drag 

and drop the variable into the desired PDO. No variable can be assigned with a static PDO.
Error Control The Error control tab for CANopen slave modules allows you to configure monitoring.
Bootup The goal of bootup procedure tab is to bypass the standard bootup procedure for devices which 

do not comply with CANopen standards.
Object Dictionary The Object Dictionary tab allows you to configure and integrate third party products, by:

 Force parameters to be transmitted even if they are unchanged, by selecting the associated 
checkbox of each parameter.

 Block parameters that do not need to be sent to the device, by unselecting the associated 
checkbox of each parameter.

 Set objects to a specific value just before (prologue), or just after (epilogue) the standard boot 
up procedure.

 Modify the current value of an object (except read only objects), if the value box is not greyed 
out. By default, if the current value is modified, the object is sent. Nevertheless, after filling the 
box, you still have the choice to modify this behaviour, by removing the mark of the checkbox 
in order to block the object sending. To prevent programming redundancies or conflicts, 
parameters which can be modified in other tabs, Configuration, PDO or Error Control, are 
greyed out in the Object Dictionary tab.

NOTE: The I/O vision of CANopen devices is based on Device DDT.
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The table below shows the procedure to launch the Catalog Manager:

The following screen shows the Hardware Catalog Manager screen:

The following table describes the Hardware Catalog Manager screen:

Step Action
1 Verify that Unity Pro software is not running

 if Unity Pro Software is running, close it
 if Unity Pro Software is not running, go to the next step

2 Select:
Start ->Programs->Schneider Electric->Unity Pro->Hardware Catalog Manager

Zone Description
Overview In this screen, you can enter a text description of the device and the related functions. It will be 

displayed in the Unity Module Editor.
PDO Mapping The PDO mapping tab opens a CANopen expert screen for PDO configuration.

The PDO mapping configuration is composed of 3 parts:
 Transmit PDOs
 Receive PDOs
 Variables

Parameters The parameters tab is used to modify the properties of parameters.
The properties of parameters are:
 Index: Indicates the index and the sub-index of the parameter (not editable).
 Parameter name: Indicates the name of the parameter (not editable).
 Minimum/Maximum: Indicates the range of authorized value (not editable).
 Value: Indicates the parameter value (editable) and is initialized with the default value find in 

the EDS.
 Attribute:
 Editable: The parameter is editable in Unity Pro CANopen screen (default value).
 Read only: The parameter is visible in Unity Pro but not editable.
 Hide: The parameter is not visible in Unity Pro but the value is sent to the device.

Bootup Procedure The goal of bootup procedure tab is to bypass the standard bootup procedure for devices which 
do not comply with CANopen standards

Object Dictionary The object dictionary screen is a CANopen Expert editor, and allows to:
 Force parameters to be transmitted even if they are unchanged.
 Suppress parameters that do not need to be sent to the device.
 Set objects to a specific value just before (prologue), or just after (epilogue) the standard 

bootup procedure.
 Modify the current value of an object (except read only objects).

EDS The EDS tab displays in read-only mode the content of the EDS used to build the device.
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The following table describes the procedure to add a device to the Catalog Manager.

The table below shows the procedure to add a function and access the configuration screen:

The table below shows the procedure to close the Catalog Manager:

Motion Function Block (MFB)
The MFB is a library which provides EFBs to easily control the axis of drive and motion devices connected 
to CANopen master. For more details, refer the MFB block in Unity Pro Help > EF/EFB/DFB Libraries > 
Motion Function Blocks.

Step Action
1 Open the Catalog Manager.
2  Select Edit → Add Device

Or
 Right-click a device family.
 Select ‘Add Device’

3 A windows dialog box appears to select the EDS or DCF file to import:
4  Select the EDS or DCF file name corresponding to the device that is to be added

 Enter a unique name for the device (optional).

Only one EDS or DCF file can be selected at a time - multiple selections are not permitted.
By default, the name of the EDS or DCF file is used as device name although it can be modified.
The device name cannot be changed after this step.

5 A screen appears showing the new device parameters. In this tab, you can sort the objects in different ways: 
either clicking the column head or selecting the checkboxes then clicking the column head again.

6 Some parameters on the device profile screen can be changed by the user:
 Family: Select the device family from the list.
 Image File: Select the image file (BMP or JPG format) associated to the device which will be displayed 

in the graphical Catalog Manager Configurator Editor. There is no limit to the size of the image. In the 
boxes included in the label zone, you define the device name position compared to the bitmap position.

 Expert Mode: Expert Mode Configuration Parameters.

When all configuration parameters are set as required, click OK.
7 Return to the Catalog Manager main screen and click the button ‘Build Catalog’ in order to save any 

changes, and to load the new device into the Catalog Manager database.
A window appears showing the progress of the catalog build.

When the build is complete, the device is indicated with a  icon.

Step Action
1 Open the Catalog Manager.
2 There are different ways to access the configuration screen:

 Right-click a device.
Select ‘Add Function"
OR

 Select a device in the Catalog Manager.
Select Edit → Add Function

3 A windows dialog box appears showing the basic configuration parameters.
4 When configuration is complete, click OK.

Return to the Catalog Manager main screen and click the button ‘Build Catalog’ in order to save any 
changes and to load the new function into the Catalog Manager database.

Step Action
1 Verify that your changes have been saved:

 If there are changes, click Build Catalog.
A window appears showing the progress of the catalog build.
When the build is complete, go to the next step

 If there are not any changes, go to the next step.

2 Select File → Exit
OR
Select Close on the main windows.
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System Bits and Words

Description
MC80 supports the following system words dedicated to communication functions. Some of them already 
exist on previous Premium or Quantum ranges but they are re-used with other semantic (highlighted in 
Bold).

%S Bit Function Unity Rd/Wr
0 - Cold-start

Normally at 0, this bit is set on 1 by: 
 Reset button
 the user program 

This bit is set to 1 during the first complete restored cycle of the PLC either in RUN or 
in STOP mode. It is reset to 0 by the system before the following cycle. 
To detect the first cycle in run after cold start, refer to %SW10. 

Rd/Wr

1 - Warm-start
Normally at 0, this bit is set to 1 by:
 power is restored with data save
 the user program 

It is reset to 0 by the system at the end of the first complete cycle and before the 
outputs are updated. 

Rd/Wr

4 - Timebase 10 ms
An internal timer regulates the change in status of this bit.
It is asynchronous in relation to the PLC cycle. 

Rd

5 - Timebase 100 ms Rd
6 - Timebase 1 sec Rd
7 - Timebase 1 min Rd
10 - Global I/O detected error

Normally at 1, this bit is set to 0 when an error on the embedded I/O or device on a 
network is detected (e.g. non-compliant configuration, exchange fault, hardware fault, 
etc.). The %S10 bit is reset to 1 by the system when all the detected errors have 
disappeared.

Rd

11 - Watchdog overflow 
Normally at 0, this is set to 1 by the system as soon as the task execution time 
becomes greater than the maximum execution time (i.e., the watchdog) declared in the 
task properties. 

Rd/Wr

12 - PLC running
This bit is set to 1 by the system when the PLC is in RUN. 
It is set to 0 by the system as soon as the PLC is no longer in RUN (STOP, INIT, etc.). 

Rd

13 - 1st scan in RUN
First cycle after switching to RUN.
Switching the PLC from STOP mode to RUN mode (including after a cold start with 
automatic start in run) is indicated by setting system bit %S13 to 1. This bit is reset to 
0 at the end of the first cycle of the MAST task in RUN mode

Rd

15 - Character string error
Normally set to 0, this bit is set to 1 when the destination zone for a character string 
transfer is not of sufficient size (including the number of characters and the end of 
string character) to receive this character string. 
The application stops in error state if the %S78 bit is to set to 1. 
This bit must be reset to 0 by the application. 

Rd

16 - Task I/O error 
Normally set to 1, this bit is set to 0 by the system when a fault on an in-rack module 
is detected (For example, non-compliant configuration, exchange fault, hardware fault, 
etc.). 
This bit must be set to 1 by the user. 

Rd/Wr

17 - Capacity overrun/carry
Rotate shift output
Normally at 0.
During a rotate shift operation, this bit takes the state of the outgoing bit. 

Rd/Wr
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18 - Overflow or arithmetic error 
Normally set to 0, this bit is set to 1 in the event of a capacity overflow if there is:
 a result greater than + 32 767 or less than - 32 768, in integer (INT) 
 a result greater than + 65 535 or less than 0, in unsigned integer (UINT) 
 a result greater than + 2 147 483 647 or less than - 2 147 483 648, in double integer 

(DINT) 
 a result greater than +4 294 967 295 or less than 0, in double unsigned integer 

(UDINT)
 real values outside limits 
 division by 0
 the root of a negative number 
 stacking up of an already full register, emptying of an already empty register.

Rd/Wr

19 - Task period overrun (periodical scanning) 
Normally set to 0, this bit is set to 1 by the system in the event of a time period overrun 
(i.e., task execution time is greater than the period defined by the user in the 
configuration or programmed into the %SW word associated with the task). The user 
must reset this bit to 0. Each task manages its own %S19 bit.

Rd/Wr

20 - Index overflow
Normally set to 0, this bit is set to 1 when the address of the indexed object becomes 
less than 0 or exceeds the number of objects declared in the configuration.
In this case, it is as if the index were equal to 0.
Test the user program after each operation where overflow may occur, then reset to 0 
if there is indeed an overflow. 
When the %S20 bit switches to 1, the application stops in error state if the %S78 bit 
has been to set to 1.

Rd/Wr

21 - 1st task scan in RUN
The bit %S21 indicates the first cycle of MAST task, including after a cold start with 
automatic start in run and a warm start.
%S21 is set to 1 at the start of the cycle and reset to zero at the end of the cycle. 

30 - Activation/deactivation of the master task 
Normally set to 1. The master task is deactivated when the user sets the bit to 0. This 
bit is taken into consideration by the system at the end of each MAST task cycle. 

Rd/Wr

40 - Local input/output fault 
The %S40 bit is assigned to rack 0. 
Normally set to 1, this bit is set to 0 when a fault occurs on the rack's I/Os. In this case:
 the %S10 bit is set to 0
 the I/O processor LED is on
 the %Ir.m.c.Err module bit is set to 1
 this bit is reset to 1 when the fault disappears

Rd

50 - Updating of time and date via words %SW50…%SW53 
Normally set to 0, this bit is set to 1 or 0 by the program or the terminal.
 set to 0: update of system words %SW50…%SW53 by the date and time supplied 

by the PLC real-time clock
 set to 1: system words %SW50…%SW53 are no longer updated, therefore making 

it possible to modify them
The switch from 1 to 0 updates the real-time clock with the values entered in words 
%SW50…%SW53. 

Rd/Wr

51 - Time loss in real-time clock 
The system-managed bit set to 1 indicates that the real-time clock is missing or that its 
system words (%SW50…%SW53) are meaningless. In this case, the clock must be 
reset to the correct time. 

Rd

59 - Incremental update of the time and date via word %SW59 
Normally set to 0, this bit can be set to 1 or 0 by the program or the terminal: 
 set to 0: the system does not manage the system word %SW59 
 set to 1: the system manages edges on word %SW59 to adjust the date and current 

time (by increment)

Rd/Wr

%S Bit Function Unity Rd/Wr
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66 - Application backup
This bit is set to 1 by the user to start a backup operation. The system will detect the 
rising edge to start the backup. The state of this bit is polled by the system every 
second. A backup takes place only if the application in RAM is different from the one 
in the flash. 
This bit is set to 0 by the system when the backup is finished. 
Warning:Before creating a new backup by setting bit %S66 to 1, you must test that bit 
%S66 has been set to 0 by the system (which means the previous backup is finished). 
Never use %S66 if it is set to 1. This may lead to a loss of data. 
Bit %S66 is particularly useful after replacement of initial value %S94 and save 
parameters. 

Rd/Wr

78 - Stop in the event of error
Normally at 0, this bit can be set to 1 by the user, to program a PLC stop on application 
fault: %S15, %S18, %20. 

Rd/Wr

80 - Reset message counters
Normally set to 0, this bit can be set to 1 to reset the message counters %SW80 to 
%SW86. 

Rd/Wr

94 - Saving adjustment values 
Normally at 0, this bit can be set to 1 by the user to replace the initial values of the 
declared variables with a ‘Save’ attribute (For example, DFB variables) with the current 
values. 
The system resets the bit %S94 to 0 when the replacement is made.

NOTE: This bit must be used with care: do not set this bit permanently to 1 and use 
the master task only. 

Rd/Wr

97 - Backup program OK 
This bit compares the application as executed in RAM versus the internal backup 
saved to flash. Values are: 
0: application backup not consistent. This state is obtained when application is auto 
modified (saveparam or replace init value) and not saved using %S66.
1: application backup is consistent

Rd/Wr

116 - global Ethernet port status
0: both Ethernet port link down
1: at least one port link up

Rd

118 - CanOpen IO errors
Normally at 1, this bit is at 0 on detection of a fault in a device on CANopen

Rd

%SW Bit Function Rd/Wr
0 - Master task scanning period

This word is used to modify the period of the master task via the user program or via 
the terminal. 
The period is expressed in ms (1...255 ms) %SW0=0 in cyclic operation. 
On a cold restart: it takes the value defined by the configuration. 

Rd/Wr

6 - IP Address LOW Rd
7 - IP Address HIGH Rd
10 - Task init First cycle after cold start 

If the value of the current task bit is set to 0, it means that the task is performing its 
first cycle after a cold start. 
 %SW10.0: assigned to the MAST task.

Rd

11 - Watchdog duration
Reads the duration of the watchdog. The duration is expressed in milliseconds 
(10...1500 ms). 
This word cannot be modified. 

Rd

12 - Modbus slave address for terminal port 
Gives the Modbus slave address of the CPU serial port. Modification is not taken into 
account. it is 0 if the CPU does not have a Serial Port link. 

Rd

14 - Commercial version of PLC processor 
This word contains the current Operating System (OS) version of the PLC processor. 
Example: 16#0135 
version: 01 
issue number: 35 

Rd

%S Bit Function Unity Rd/Wr
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15 - PLC processor patch version 
This word contains the commercial version of the PLC processor patch. 
It is coded onto the least significant byte of the word. 
Coding: 0 = no patch, 1 = A, 2 = B... 
Example: 16#0003 corresponds to patch C. 

Rd

16 - Firmware version number
This word contains the Firmware version number in hexadecimal of the PLC 
processor firmware. 
Example: 16#0011 
version: 2.1 
VN: 17 

Rd

17 - Error status on floating operation
When an error in a floating arithmetic operation is detected, bit %S18 is set to 1 and 
%SW17 error status is updated according to the following coding: 
 %SW17.0 = Invalid operation / result is not a number
 %SW17.1 =Denormalized operand / result is acceptable (flag not managed by 

Modicon M340 or Quantum Safety PLCs)
 %SW17.2 = Division by 0 / result is infinity
 %SW17.3 = Overflow / result is infinity
 %SW17.4 = Underflow / result is 0
 %SW17.5 to 15 = not used

This word is reset to 0 by the system on cold start, and also by the program for re-
usage purposes.

Rd/Wr

18, 19 - Absolute time counter 
%SW18 represents the least significant bytes and %SW19 the most significant bytes 
of the double word %SD18, which is incremented by the system every 1/10th of a 
second. The application can read or write these words in order to perform duration 
calculations.
%SD18 is incremented systematically, even in STOP mode and equivalent states. 
However, times when the PLC is switched off are not taken into account, since the 
function is not linked to the real-time scheduler, but only to the real-time clock.
For Quantum safety PLC, knowing that the 2 processors must process exactly the 
same data, the value of %SD18 is updated at the beginning of the mast task, and then 
frozen during the application execution. 

Rd/Wr

20 - 1 ms counter low Rd
21 - 1 ms counter high Rd
23 - Rotary switch value Rd

7...0 Rotary switch value(Ethernet role name) Rd
8 Rotary switch change since power up Rd
9 Rotary switch error Rd

26 - Number of requests processed
This system word allows to verify on server side the number of requests processed by 
PLC per second. 

Rd/Wr

27, 28, 29 - System overhead time 
 %SW27 is the last system overhead time. 
 %SW28 contains the maximum system overhead time. 
 %SW29 contains the minimum system overhead time. 

The system overhead time depends on the configuration (number of I/O) and on the 
current cycle requests (communication, diagnostics).
System overhead time = Mast Cycle Time - User code execution time.
This can be read and written by the user program or by the terminal.

Rd/Wr

30 - Master task execution time 
This word indicates the execution time of the last master task cycle (in ms). 

Rd/Wr

31 - Maximum master task execution time 
This word indicates the longest master task execution time since the last cold start (in 
ms).

Rd/Wr

32 - Minimum master task execution time
This word indicates the shortest master task execution time since the last cold start 
(in ms).

Rd/Wr

%SW Bit Function Rd/Wr
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49…53 - Real-time clock function
System words containing date and current time (in BCD): 
 %SW49: day of the week: 
  1 = Monday 
 2 = Tuesday 
 3 = Wednesday
 4 = Thursday
  5 = Friday
 6 = Saturday
 7 = Sunday

 %SW50: Seconds (16#SS00)
 %SW51: Hours and Minutes (16#HHMM)
 %SW52: Month and Day (16#MMDD)
 %SW53: Year (16#YYYY)

These words are managed by the system when the bit %S50 is set to 0. 
These words can be written by the user program or by the terminal when the bit %S50 
is set to 1. 
For M580: 
The current time is in UTC (Coordinated Universal Time). If a local time is needed, use 
the RRTC_DT function. 

Rd/Wr

54…58 - Real-time clock function on last stop
System words containing date and time of the last power failure or PLC stop (in Binary 
Coded Decimal): 
 %SW54: Seconds (00SS)
 %SW55: Hours and Minutes (HHMM) 
 %SW56: Month and Day (MMDD) 
 %SW57: Year (YYYY)
 %SW58: the most significant byte contains the day of the week (1 for Monday 

through to 7 for Sunday), and the least significant byte contains the code for the 
last stop: 
  1 = change from RUN to STOP by the terminal or the dedicated input
 2 = stop by watchdog (PLC task or SFC overrun)
 4 = power outage or memory card lock operation
 5 = stop on hardware fault
 6 = stop on software fault. Details on the type of software fault are stored in 

%SW125

Rd

59 - Adjustment of current date
Contains two 8-bit series to adjust the current date. 
The action is always performed on the rising edge of the bit. 
This word is enabled by bit %S59=1. 

Rd/Wr

70 - Week of year 
System word containing the number of the week in the year: 1…52 (in BCD).

Rd

76 - Diagnostics function: recording
Result of the last registration 
 = 0 if the recording was successful 
 = 1 if the diagnostics buffer has not been configured 
 = 2 if the diagnostics buffer is full

Rd/Wr

77 - Diagnostics function: non-recording
Result of the last de-registration
 = 0 if the non-recording was successful
 = 1 if the diagnostics buffer has not been configured
 = 21 if the error identifier is invalid
 = 22 if the error has not been recorded

Rd/Wr

78 - Diagnostics function: number of errors 
Number of errors currently in the diagnostics buffer. 

Rd

80, 81 - Message management 
These words are updated by the system, and can also be reset using %S80. 
 %SW80: Number of message sent by the system to the terminal port (Modbus 

serial port)
 %SW81: Number of message received by the system to the terminal port (Modbus 

serial port). 

Rd

%SW Bit Function Rd/Wr
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84, 85 - Message send to USB
These words are updated by the system, and can also be reset using %S80. 
 %SW84: Number of messages sent to the USB port 
 %SW85: Number of messages received by the USB port.

Rd

86 - Modbus exception messages
This word is updated by the system, and can also be reset using %S80.
 Number of messages refused by the system, not treated because of lack of 

resources for example. If the message is refused by Modbus Server then it 
corresponds to Modbus exception messages, sent by the CPU to the remote 
Modbus client. 

87 - Communication flow management 
Number of requests processed by synchronous server per master (MAST) task cycle. 
The requests processed may come from all communication ports.

90 - Maximum number of requests processed per master task cycle
N=4(minimum 2, maximum 4 + 4 = 8)

Rd/Wr

94, 95 - Application modification signature
These two words contain a 32-bit value that changes at every application modification 
except when: 
 updating upload information
 replacing the initial value with the current value 
 saving the parameter command

Rd

96 - Command and Diagnostic of Save and Restore Rd/Wr
108 - Forced bit counting status register 

Word %SW108: 
 increments each time an discrete bit (%I,%Q or %M) is forced 
 decrements each time an discrete bit is unforced 

Rd

124 - Type of processor or system error
The last type of system fault encountered is written into this word by the system (these 
codes are unchanged on a cold restart): 
 16#30: system code fault 
 16#53: time-out fault during I/O exchanges 
 16#60 to 64: stack overrun 
 16#65: Fast task period of execution is too low 
 16#81: detection of backplane error 

NOTE:  If this error is detected, all racks have to be re-initialized.

 16#90: Detected Internal system error: Unexpected interruption 

Rd

125 - Last fault detected
The code of the last fault detected is given in this word. The following error codes 
cause the PLC to stop if %S78 is set to 1.
%S15, %S18 and %S20 are always activated independently of %S78: 
 16#2258: execution of HALT instruction 
 16#DE87: calculation error on floating-point numbers (%S18, these errors are 

listed in the word %SW17) 
 16#DEB0: Watchdog overflow (%S11) 
 16#DEF0: division by 0 (%S18) 
 16#DEF1: character string transfer error (%S15) 
 16#DEF2: arithmetic error; %S18 
 16#DEF3: index overflow (%S20) 

NOTE: The following codes 16#8xF4, 16#9xF4, and -16#DEF7 indicate an error on 
Sequence Function Chart (SFC). 

Rd

126…127 - Blocking error instruction address
Address of the instruction that generated the application blocking error.
 %SW126 contains the least significant word for this address 
 %SW127 contains the most significant word for this address 

For a system STOP due a watchdog overflow: 
 %SW126 contains the number of the MAST task with the overflow 
 %SW127 contains the value of the MAST task with the overflow 

Rd

128 - IP Netmask low Rd
129 - IP Netmask high Rd
130 - IP Gateway low Rd
131 - IP Gateway high Rd

%SW Bit Function Rd/Wr
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132 - MAC address low Rd
133 - MAC address medium Rd
134 - MAC address high Rd
135 - FDR Client Status

0 = not initialized 1 = IP initialized 3= link ETH down 4= IP duplicate 5 = Wait for server 
6= no conf or conf error 7= configuration conflict 

Rd

136 - RSTP status Rd
2...0 Eth port 1 RSTP port role (0=none, 1 = alternate , 2=backup, 3=root, 4= designated, 

5=non-RSTP port)
Rd

5…3 Eth port 2 RSTP port role Rd
137 - P502 opened connection nbr server mode Rd
138 - P502 opened connection nbr client mode Rd
146 - Communication status of Master Rd

1 = 1: FIFO full cause message lost
2 = 1: CAN controller BUS OFF
3 : Reserved
4 = 1: CAN controller is warning status
5 = 1: Overflow of the low priority emission queue. The CANopen Master transmits 

"Heartbeat" and "Node guarding" messages as well as SSDOs and CSDOs via the 
low priority transmission queue.

6 = 1: Overflow of the high priority reception queue. The CANopen Master receives 
RPDOs, NMT commands, the message Sync and emergency messages via the high 
priority reception queue.

7 = 1: Overflow of the high priority transmit queue. The CANopen Master sends TPDOs, 
NMT commands, the message Sync and emergency messages via the high priority 
queue.

147 - Status of CANopen Master Rd
- = 0x00 INIT: The CANopen Master is not initialized. This corresponds to the 

INITIALISATION status of the CANopen module. In this state, the CANopen Master 
cannot communicate with the network.

- = 0x40 RESET: The CANopen Master is configured as master during NMT STARTUP. 
The object dictionary of CANopen Master can be configured by SDOs via the CAN bus 
and the interface of the SDO command. The application has read/write access rights 
to the object

- = 0x60 NET INIT: Start-up according to CIA DSP-302. The CANopen Master checks 
the allocation of the slaves.

- = 0x61 NET RESET: The network is re-initialized by the NMT command RESET 
COMMUNICATION ALL NODES.

- = 0x62 NET WAIT: The CANopen Master waits (waiting time be defined) to allow the 
modules to run the command RESET COMMUNICATION.

- = 0x64 BOOT CONF: The CANopen Master initializes modules according to CIA DSP-
302 by scanning the network.

- = 0x8x CLEAR: The network is scanned. The Master is waiting for a start command 
(START CANopen MASTER/MANAGER or START NETWORK).

- = 0xAx RUN: The network is in the OPERATIONAL state.
- = 0xCx STOP: The network is in the STOP state.
- = 0xEx PREOPERATIONAL: The network is in the PREOPERATIONAL state.
- = 0x9x FATAL ERROR: The CANopen Master is inoperative and must be re-

initialized.

%SW Bit Function Rd/Wr
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148 - Event indicator Rd
0 = 1: This bit is always set when a detected error has occurred in communication with 

the network. The communication status of CANopen Master gives the exact reason. 
(The CANopen Master is unable to run correctly and stops).

1 = 1: A module is using the node number of CANopen Master. (The CANopen Master 
is unable to run correctly and stops).

2…3 : Reserved
4 = 1: There is a detected identity error for an optional module. The boot slave process 

is repeated.
5...6 : Reserved.
7 = 1s: This bit is set if a bit in one of the bit lists changes.
8 = 1: At the beginning of the start-up procedure, the CANopen Master checks the 

individual slave assignments. This bit is set by the slave assignment if a module that 
contain features which are not supported by the CANopen Master (for example, bit 4 
to bit

9 = 1: The CANopen Master has received an RPDO with not enough data bytes. (The 
CANopen Master does not change its state.)

10 = 1: Inconsistent or mismatch DCF bit.
11 : Reserved.
12 = 1: The last Master/Manager cycle time is greater than 256 ms.
13 = 1: The Master is the only CAN device on the network. It gets no acknowledgment to 

its transmitted frames. All nodes are marked as absent. The Master keeps its state 
until the ““alone”” situation is released.

14...
15

: Reserved

149 - Master Command Information Rd/Wr
2 : Reset bit 7 (change bit list) of event indicator (%SW148)
3 : Reset all the bus analysis information (%SW155...%SW159, %SW176...%SW177)
5 : Reset the CANopen master

150 - SDO Abort code low Rd/Wr
151 - SDO Abort code high Rd/Wr
152 - CANopen Node number Rd/Wr
153 - CANopen Index Rd/Wr
154 - CANopen Sub-index Rd/Wr
155 - CANopen Error A: Number of bits erro Rd/Wr
156 - CANopen Error B: Number of form error Rd/Wr
157 - CANopen Error C: Number of stuff error Rd/Wr
158 - CANopen Error D: Number of other errors Rd/Wr
159 - CANopen Error E: Last error code capture register: this register contains information 

about type and location of errors on the bus
Rd/Wr

160 - Local IO health
bit 0: reserved
bit 1: 0 in case of error on HSC, else 1
bit 2: 0 in case of error on DDM, else 1
bit 3: 0 in case of error on AMI, else 1

Rd/Wr

168 - CANOpen List of Assigned but configured slaves Rd
169 - CANOpen List of Configured Slaves Rd
170 - CANOpen List of Slaves with configuration faults Rd
171 - CANOpen List of Inoperative Slaves Rd
172 - CANOpen List of Operational Slaves Rd
173 - CANOpen List of Stopped slaves Rd
174 - CANOpen List of Pre-operational slaves Rd
175 - Number of CANOpen transmitted messages Rd
176 - Number of CANOpen received messages Rd
177 - Current CANOpen master cycle time Rd

%SW Bit Function Rd/Wr
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178 - CANOpen master maximum execution time Rd
179 - CANOpen master minimum execution time Rd
180 - CANOpen master assigned cycle time Rd/Wr
181 - Ethernet Port 0 Rx Bad Frames Counter Rd
182 - Ethernet Port 0 Collisions Counter Rd
183 - Ethernet Port 0 In Filtered Counter Rd
184 - Ethernet Port 1 Rx Bad Frames Counter Rd
185 - Ethernet Port 1 Collisions Counter Rd
186 - Ethernet Port 1 In Filtered Counter Rd
187 - RSTP Topology Change Counter Rd

%SW Bit Function Rd/Wr
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Chapter 13
MC80 Firmware Upgrade

Firmware Upgrade

Description
The MC80 PLC Firmware upgrade is done using Unity Loader. The MC80 PLC provides a fast and reliable 
firmware upgrade from the Unity Loader to PLC through USB connection or through Ethernet connection.
For upgrading, select the correct .ldx file and then connect to the PLC.
NOTE: 
 BMK C80 ••••• processors have different .ldx files.
 If an application is present before starting an upgrade then the CPU must be in stop mode. Stop 

command is available from Unity Loader.
 The Firmware upgrade cannot be performed with serial port connection.

Security Features
The Firmware Upgrade feature can be enabled or disabled in Unity Pro configuration. This feature is 
disabled in default state.
NOTE: Before upgrading, you have to change the Unity Pro configuration to enable the Firmware Upgrade 
feature.
The following describes the Firmware upgrade process:
 When FW upgrade process is started, the CPU enters a specific state where only the communication 

with Unity Loader is active and the state is shown by an LED combination.
 At the end of upgrade, the CPU will reboot with a new version and the application is stored in flash.
 In the stop mode, the CPU does a cold start and if the run option is checked, the application starts 

automatically.
 If there is an error during the FW upgrade (connection broken or power outage of CPU), the CPU must 

be reset and restarted with old OS.
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